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1. Introduction

1.1. Overview
Neat Video is a filter designed to reduce noise and grain in digital video.

Neat Video detects, analyzes and reduces noise. The quality of noise reduction provided by Neat Video
is higher than that of other methods because Neat Video incorporates the most advanced noise reduction
algorithms in the industry and takes into account specific characteristics of particular video capturing
devices – video camera, camcorder, computer TV-tuner, etc., – making the filtration customized and more
accurate.

In addition, Neat Video can make video look sharper without any degradation of quality. The combination
of the sharpening and noise filter makes such effect possible.

Neat Video plug-in for Resolve (Win) is available in three editions: Demo, Home, Pro.

• Demo plug-in is a free edition of the software with limited functionality;

• Home plug-in works with up to 1920x1080 pixel large frames; for non-commercial use only;

• Pro plug-in has no frame size limitations; can be used on a fixed set of computers for commercial
purposes.

1.2. Features

Noise Reduction and Smart Sharpening

• Advanced noise filters to reduce noise and grain in digital footage


 Temporal filter to reduce noise, dust, scratches, etc. using data from consecutive frames


 Spatial filter to further reduce noise and artifacts within each single frame

• Complete control over the noise filter to achieve the desired level of noise reduction

• Smart sharpening filter to make video look sharper without amplification of noise

• High-bitdepth rendering to fully support professional applications

• CUDA and OpenCL acceleration to speed up processing using computation-capable GPUs

Device Noise Profiles

• Custom noise profiles to make noise reduction device-specific and more accurate

• Auto Profile function to build noise profiles for custom video-capturing devices

• Generic Profile function to create custom profiles without using noise samples

Some features are only available in the Home or Pro plug-in. Detailed feature map (page 57) describes the
differences between editions of Neat Video plug-in.
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1.3. Requirements
Recommended system configuration is:

• Intel x64 or AMD x64 series processor, single or multi-processor

• Windows 11, 10, 8, 7; 64-bit

Optional CUDA acceleration requires:

• CUDA-capable NVIDIA GPU with compute capability 3.5 or higher
(check the compute capability of an NVIDIA GPU in https://developer.nvidia.com/cuda-gpus)

• Recent video driver supporting CUDA 9 or newer
(you can download the latest versions of the video drivers from
https://www.nvidia.com/Download/index.aspx)

Optional OpenCL acceleration requires:

• Supported AMD video card:


 AMD Radeon HD 7790;


 AMD Radeon R7 260/260X/360;


 AMD Radeon R9 285/285X/290/290X/295X2;


 AMD Radeon R9 380/380X/390/390X;


 AMD Radeon R9 Fury, R9 Nano, R9 Fury X, Pro Duo;


 AMD Radeon RX 460/470/480;


 AMD Radeon RX 540/540X/550/550X/560/570/580;


 AMD Radeon RX Vega 56/64;


 AMD Radeon Vega Frontier Edition;


 AMD Radeon RX 5300M/5500/5500M;


 AMD Radeon RX 5600/5600M/5600 XT/5700/5700M/5700 XT;


 AMD Radeon RX 6600/6600 XT;


 AMD Radeon RX 6700 XT/6800/6800 XT/6900 XT;


 AMD Radeon RX 7600S/7600M/7600M XT/7700S/7900M;


 AMD Radeon RX 7600/7700 XT/7800 XT/7900 GRE/7900 XT/7900 XTX;


 AMD Radeon Pro WX 2100/3100/4100/5100/7100/9100;


 AMD Radeon VII;


 Another AMD GPU based on one of the following chip series: Bonaire, Hawaii, Tonga,
Fiji, Ellesmere, Baffin, gfx804, gfx900, gfx901, gfx906, gfx907, gfx90c, gfx1010, gfx1012,
gfx1030, gfx1031, gfx1032, gfx1100, gfx1101, gfx1102

• The latest version of AMD Adrenalin driver.

If you experience a problem with the latest version of the driver, please check the known issues
page for possible solutions:

https://www.neatvideo.com/support/known-issues

You can download the latest and archive versions of AMD Driver from

https://www.amd.com/en/support

System requirements for practical use of Neat Video depend on frame size and length of video. Processing
larger frames and longer clips takes proportionally more time than smaller and shorter ones. The processing
speed is determined primarily by the processor speed, GPU speed and memory speed.

The Neat Video plug-in can process any RGB video clip supported by Resolve (Win).
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Neat Video v5 plug-in for Resolve (Win) is compatible with the following versions of Resolve (Win):

• DaVinci Resolve / Resolve Studio 18.5 / 18 / 17 / 16 / 15 / 14 / 12.5 / 12 / 11 / 10

The plug-in may be compatible with other versions of Resolve (Win) as well.
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2. Key concepts

Neat Video is a digital video filter. Its main function is to reduce noise in digital video.

Neat Video can work with video clips produced by any video recording devices – video cameras, drone
cameras, mobile phones, camcorders, computer TV-tuners, film digitizers, etc. The software can be
adjusted to a particular device by means of a device noise profile, which describes the noise characteristics
of the device working in a certain mode.

A device noise profile is built by analyzing those areas of a video frame that contain visible noise and
do not contain any visible or important details. Usually, Neat Video can find such featureless areas
completely automatically. In a difficult case, you can assist it and select a featureless area manually.
Finding such areas is very easy for human eyes but may sometimes be a bit difficult for software.

By analyzing featureless areas in a frame, Neat Video builds a profile which describes the noise in these
areas. With this profile, Neat Video can efficiently reduce noise in the frame and in the whole video clip.

The noise filter processes video data in several spatial frequency ranges. This makes possible reducing
noise in one frequency range even if details are present in other ranges. The filter can also selectively
process any of the color channels.

Besides spatial filtration, Neat Video also applies temporal (inter-frame) filtration to video data. Neat Video
uses several consecutive frames to better reduce noise and preserve more true details in each frame. This
improves the overall quality of noise reduction.

Neat Video also offers specialized tools to deal with dust, scratches, artifacts, damages to details caused by
in-camera noise reduction, sharpening, compression, repeated frames, etc.

In addition, Neat Video includes a smart sharpening filter, which only sharpens details without increasing
the level of noise. This filter also uses the noise profile to tell noise from details, so applying the noise and
sharpening filters together saves time and produces better overall results.
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3. Installing the plug-in

To install the Neat Video v5 plug-in for Resolve (Win)

1. Make sure you have started DaVinci Resolve at least once before installing the plug-in. If you have not
done it yet, start DaVinci Resolve and exit it;

2. Close DaVinci Resolve if it is running now;

3. Download the EXE installer of Neat Video

• if you already purchased the product and have a current license for the Home or Pro plug-in,
then please download the corresponding plug-in from your account on the website of Neat Video:
https://www.neatvideo.com/account/products

• if you want to try Neat Video before purchase, then please download the installer of the Demo
plug-in from this page: https://www.neatvideo.com/download

4. Double-click the downloaded EXE file to start the installer;

5. Follow the steps of the installer wizard to complete the installation process.

6. Start the host application and check whether Neat Video (Reduce Noise v5) is available in the list of
video effects / filters. It should appear in the Color tab, the OpenFX panel, Library.

If Neat Video has not become available in DaVinci Resolve, please contact Neat Video support for
assistance.
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4. Running Neat Video on a sample video clip

If you just start using Neat Video, please follow one of the Quick Start Guides prepared on the website of
Neat Video: https://www.neatvideo.com/support/how-to-use

There are several Quick Start Guides for different video editing applications available there. Please select
the Quick Start Guide that matches the application you are using.
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5. Filtration process details

This section explains in more details how to apply the Neat Video noise reduction to a video clip.

5.1. Stage I. Add the Reduce Noise effect
Find the Neat Video (Reduce Noise v5) effect in Resolve (Win) before adding it to the clip in your
project.

è 1. Go to the Color page in Resolve (Win).

2. Click the magnifying glass button at the upper right-hand corner of the OpenFX panel (to display
the OpenFX panel).

3. In the OpenFX panel, navigate to Library > Neat Video > Reduce Noise v5 in the list (but do not
use/add it yet).

5.2. Stage II. Select a frame for noise analysis

Neat Video filter uses a frame (or fields1) from the video clip to analyze noise and build a noise profile
necessary to reduce noise in the clip. This frame should include flat featureless areas that contain no
visible details, but do contain noise. To build a noise profile you need to manually find such a frame in
the video clip using the Resolve controls. If there are many frames that contain flat featureless areas then
select one with larger and most noisy flat featureless areas without visible details.

è Use the timeline controls to select a frame with large flat featureless area; the selected frame will be
used for analysis in the next stages.

5.3. Stage III. Open Neat Video plug-in window
è 1. Drag-n-drop Reduce Noise v5 to the node of

the clip in the Nodes Editor panel. This will
enable the Settings tab in the OpenFX panel.

2. Open the Neat Video plug-in window using
the Prepare Noise Profile button in the
effect’s settings panel.

(If you run Resolve 14 or older, then please
click the Prepare Frames button before using
Prepare Noise Profile.)

If you run the Demo plug-in, click OK in the popup splash screen of the plug-in to proceed further.

The Neat Video plug-in window will open and show the current frame (for progressive video). For
interlaced video either one field (upper or lower) or both fields will be shown. This frame, field or fields
will be used to build a noise profile necessary to filter the whole clip.

1 The term “frame” will be used to refer to either a frame (in progressive video) or fields (in interlaced video).
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5.4. Stage IV. Check input frame

Scan type

Neat Video filter can work with video of both progressive and interlaced scan types. Neat Video works
with these two scan types in slightly different ways so it is necessary to let the filter know what kind of
video is processed before configuring other filtration parameters.

è In the left bottom corner of the Neat Video plug-in window, select either Progressive or Interlaced
depending on the scan type of the current video.

Neat Video may also explicitly ask you to specify the scan type using a dialog window. That is done when
you open the Neat Video plug-in window for the first time in the current session of the host application.

If the Progressive scan type is mistakenly selected for an interlaced video then
you may see some interlacing artifacts (combing) on moving objects when
using the 100% or higher zoom level in the viewer. An example of such artifacts
is shown in the picture on the right. Presence of such artifacts in the frame
displayed inside the Neat Video window usually indicates that the scan type
has been set incorrectly and it is necessary to select the Interlaced scan type
instead.

Please note that the scan type of your video is generally controlled by the
properties of the project. So if you want to change the scan type, then please change it in the project
properties in the first place.

Gamma correction

If the host application can work with different types of data, such as gamma corrected data vs linear
data, then Neat Video may offer a dedicated control to manually adjust the data type in the plug-in itself.

That control ( , the Input Data Type button) is then available in the lower bottom part of the plug-in
window.
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To adjust the data type manually, please check the preview in
Neat Video viewer. If the frame shown by Neat Video looks
significantly darker or lighter (see the examples on the right)
than the same frame in the host application, then check whether
the input data type is specified correctly in Neat Video.

è Use to control and specify the correct type of input
data:

• select Linear if the host application
is providing frames in linear format;
(that is the default in Nuke for example);

• select Gamma corrected if the host application is
providing frames with a gamma correction applied
(sRGB and similar color spaces).

Please note that the Input Data Type control is enabled only when the 32 bits per channel (float) pixel
format (color depth) is used by the host application. It is disabled when the 8 or 16 bits per channel format
is used (the frame data are assumed to be gamma corrected then).

In some host applications, you can change the pixel format in the project settings of the host application if
necessary. Please check the documentation of the host application to learn more about that.

Viewer controls

To inspect the content of the frame (this will be used a lot in the next sections) you can use the controls
and shortcuts described below.

è To change zoom level

• use the mouse wheel when the mouse pointer is over the viewer;

• use the zoom control under the viewer;

• use the Ctrl-Plus, Ctrl-Minus, Ctrl-0, Ctrl-Alt-0 keyboard shortcuts.

è To scroll and pan the frame

• press the spacebar and the left mouse button and then drag the frame using the mouse;

• press the middle mouse button and then drag the frame using the mouse.

5.5. Stage V. Prepare a device noise profile
To filter the noise in the clip, Neat Video needs to know the characteristics of noise produced by the video
capturing device (video camera, drone camera, TV-tuner, etc.). The noise characteristics of a device
working in a certain mode constitute a device noise profile.

There are three ways to prepare a device noise profile for the clip in Neat Video:

• To build a new profile using a suitable frame from the clip;

• To create a new generic profile and tune it to the clip;

• To select and load a suitable profile from a pre-built set of profiles
(when you already have such a set).

The first option is often the easiest and most accurate one provided the selected frame contains sufficiently-large
uniform featureless areas that include noise but do not include any details of the scene itself. Neat Video
can try to automatically find such areas in the frame and in adjacent frames and then analyze noise in there
to build a noise profile. If the selected frame or its adjacent frames contain such areas suitable for analysis,
then this way of preparing a noise profile is the most accurate and therefore recommended.

If the current frame (and other frames of the clip) contains no such noise-only detail-free areas, then
creating a generic profile is the next available option.
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Or if you have already built and saved several profiles for various modes of your camera, then you can
manually select and load the profile that corresponds to the current clip (the current clip must show the
same noise as that used to build the chosen profile).

Another possible scenario is to shoot a special test clip using the Calibration Target (available in Neat Video
webpage: https://www.neatvideo.com/support/how-to-use/calibration-target ), build a noise profile using
that clip, save that profile and then load it when working on your actual clip (produced in the same camera
mode).

In most cases, the first option above is still the most efficient in terms of time and quality, so below we
will describe it in detail first.

To build a new profile using a frame from the clip

I. Build a new profile using Auto Profile

If you have found a frame with areas containing visible noise and no details, then you can build a noise
profile for the clip by following steps below:

è 1. Make sure you use the Prepare Noise Profile tab:

2. Click (the Auto Profile button).

Auto Profile function will try to automatically find and select an area containing a sample of pure
noise (without any details of the scene) for analysis. Auto Profile will look for such areas in the
current and adjacent frames1 to find the most suitable area showing the strongest noise. Neat Video
will then select the found area and automatically analyze the noise in that area to build a new noise
profile based on it. Neat Video will automatically analyze the rest of the frame too. However, the
most important part of the analysis is the selected area, which is why it is highlighted in the viewer
to help you visually inspect the area to make sure there are no details or other issues there.

3. Once Auto Profile selects the area used for analysis, please visually inspect it to verify that the area
does indeed satisfy the following requirements (recommended to achieve the best results):

• The area should contain visible noise;

• The noise should look typical for the current clip;

• The noise should be the strongest among all such areas present in this and adjacent frames
(you can use the noise strength indicator shown over the selection to check that);

1 If you want to make Auto Profile look for that area in the current frame only, then click and hold the Auto Profile button and then
select Auto Profile (Current Frame) in the popup menu, or use the main menu Profile > Auto Profile (Current Frame).
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• The area should contain no scene details of any kind (objects, textures, gradients, etc.);

• The area should contain no dust/scratches (for old film-based videos);

• The area should not be very dark (near black) nor very bright (near white);

• The area should be as large as possible in that frame.

Auto Profile generally tries to find an area that satisfies these requirements but that may be not
always possible to achieve. In difficult cases, it may be not able to find a large enough area or area
without details. You will then notice that the selected area, for example, contains some details or
has some other issues. In such cases, Neat Video also warns you that the area may be not very
suitable for analysis. It may say that the selected area is not uniform in one or more channels, or is
small, or contains too weak noise or clipping in some channels.

If you receive such a warning about possible non-uniformity, clipping, small size of the area, etc.,
then you generally have two options:

• You can choose to ignore the warning and proceed using the area found by Auto Profile.
However, the accuracy of the resulting noise profile may be lower than it could in principle
be with that clip. Technically, the filter will still work but the quality of the results may be
lower.

• You can try to resolve the reported issue: manually move the selection (or resize, or draw
a new one) to another area that does not have that problem (does not contain any visible

details, contains stronger noise, is larger, etc.) and then click (the Build
Profile button 1) to re-build the profile using the newly selected area.

To visually inspect areas found by Auto Profile and to manually find the most suitable areas, use
the YCrCb+ mode of the image viewer. It helps to better see any weak details that may be present
in the candidate image areas. The YCrCb+ mode emphasizes the weak details and noise present in
Luminance (Y), Cr and Cb channels, as shown in the example below:

The top image shows the original frame where details around the sun are barely visible, while
the channels in the bottom part display the image data in such a way as to emphasize those weak

1 The Auto Profile button will change its name to Build Profile in this situation when the selection is added manually or moved.
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details. That helps to visually verify that the selected area contains no useful details, which is very
important for accurate noise analysis.

II. Tune the profile using Profile Check (optional)

After you have built the profile, you can visually check its accuracy and additionally tune it using a special
preview mode and tuning controls. To do that please follow these steps:

è 1. Make sure the zoom level of the preview is set to 100-200%. Set the viewer mode to YCrCb+.

2. Click (the Profile Check button) in the toolbar.

Profile Check will enable a special preview mode that shows the results of noise reduction being
applied using the current profile in such a way as to emphasize the areas of the frame where the
noise is not sufficiently reduced.

Profile Check intentionally applies stronger noise reduction so some details may be lost or look
plastic in that preview, but that should not cause a big concern at this point.

What is important at this point is to make sure the noise is sufficiently reduced in large empty areas
within the frame as well as on edges of those areas and edges of objects.

If you see that such large empty areas or edges are not sufficiently cleaned in the Luminance (Y)
channel1, then try the following measures:

• If the remaining noise is present along edges of objects, then increase the Noise Level
setting (or Noise Level > Luminance setting available in Advanced Mode) until those
noise elements disappear in preview. Be careful, do not increase the Noise Level settings
higher than what is needed to remove the remaining noise;

• If the remaining noise occupies large space in empty areas, then you can simply re-build the
profile using a noise sample from such an area (select it and click Build Profile);

• If the remaining noise occupies a small area, then you can also use manual Fine-Tune
on a sample of that noise (this is available in Advanced Mode only; using Fine-Tune is
described in the Device noise profiles section, page 39).

3. Check preview in adjacent frames too, because there may be more remaining noise there.

To see any of the adjacent frames click any of the thumbnails in the bottom of Neat Video window:

The selected frame is then displayed in the main viewer.

If necessary, additionally adjust the Noise Level settings to sufficiently reduce the remaining noise
in those adjacent frames.

4. Now check preview in the chrominance (color) channels Cr and Cb (this is only available in
Advanced Mode). If there is any remaining noise in those channels, then try to increase the
corresponding Noise Level settings: Cr and Cb.

5. After the profile is built and tuned, check the Quality indicator in the
Device Noise Profile box. A profile built using a large uniform and
featureless area will usually show a high value in that indicator. That is
not strictly necessary, but it is usually good to have a high value (like higher than 60%) there. High
values usually lead to more accurate noise reduction.

If the reported quality is high and you are satisfied that the noise is sufficiently reduced when you
check the preview in steps 2-4 above, then you can consider the profile ready and proceed to the
next stage: Stage VI. Adjust filter settings, page 16.

If the quality is not high or you clearly see that some noise elements are still present even after
tuning, then you may want to re-build the profile using a different area, probably from an adjacent
frame or from a farther away frame in the same clip.

If you cannot find a better frame and area for analysis or cannot build a better noise profile using
this method, then consider creating a generic profile as described in the next section.

1 At this point, check the Luminance (Y) channel only. The other channels will be checked a bit later.
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To create a generic profile

There may be some cases when frames of the clip you are working with have no featureless areas suitable
for building an accurate noise profile, and no pre-built profiles are available for that particular camera. In
such cases, you can use the Generic Profile function to create a generic noise profile and then tune it to
match the noise in your clip. You can do that by following these steps:

I. Create a new generic profile

è Click (the Generic Profile button).

Generic Profile will create a new generic noise profile and that profile is then automatically loaded
into this instance of Neat Video filter.

II. Tune the profile to the clip

Generic Profile creates a profile with the default noise strength that may be not right for your clip and so
you will most likely need to adjust it to match the actual noise present in the clip.

To help you do that, Generic Profile will open the Profile
Check and Tuning section in the Device Noise Profile panel
and will automatically enable the preview mode showing the
results of noise reduction based on the current profile. It will help to see where the noise is not sufficiently
reduced.
è Adjust the Generic Noise setting in the Profile Check and Tuning section to make the noise fully

reduced in preview, while keeping the details mostly preserved. Set it to the lowest number that is still
able to reduce all noise but do not go any higher.

The preview intentionally applies stronger noise reduction so some details may be damaged or look
plastic there, but that should not cause a big concern at this point (the final results will look better).

What is important at this point is to make sure the noise is sufficiently reduced in all areas of the frame,
especially in areas where the noise is strongest.

III. Further tune the profile to the clip (optional)

You can further tune the profile to the clip to better match the noise in individual channels (this is
only possible in Advanced Mode). This may help to improve the quality of noise reduction a bit.

è 1. Make sure the viewer mode is set to YCrCb+.

2. Check the Luminance (Y) channel to see if any
remaining noise is present there, in different parts
of the frame. If necessary, adjust the Noise Level >
Luminance setting.

Also check that in adjacent frames. There may
be more noise. If necessary adjust Noise Level >
Luminance further.

3. Similarly check the Chrominance channels Cr and
Cb. If necessary, adjust the Noise Level > Cr and Cb
settings.

4. Once you are satisfied that the noise is sufficiently
reduced in all channels, you can consider the profile
ready and proceed to the next stage: Stage VI. Adjust
filter settings, page 16.

To select and load a profile from a pre-built profile set

If you have already built some noise profiles earlier and saved them to the disk, you can re-load one of
those profiles to use with the current clip. You need to make sure you select the right noise profile from

17-Jan-2024 Neat Video © 1999-2024 Neatlab, ABSoft. All rights reserved. 15



User Guide Neat Video v5 plug-in for Resolve (Win)

the set: it should be for the same noise as that present in the current clip. If the current clip and the clip
used to build the loaded profile were produced by the same camera working in the same shooting mode,
then the noise in both clips would most be likely the same, so that profile would be suitable for the current
clip too.

I. Load an existing profile

è Click (the Load Profile button). Then select a profile in the Open Device Noise
Profile dialog.
OR
Click (the drop-down button) in the Device Noise Profile box to open the popup menu showing
all profiles currently available1 in Neat Video’s Profile folder and then select one of those profiles.

By default, the Profile folder is located in your Documents folder:2

Documents\Neat Video v5 for Resolve\Profiles\

If you build or download some pre-built profiles, save them to that folder and Neat Video will show
those profiles in the popup menu to help you quickly load any of them.

II. Tune the loaded profile to the clip

You may want to additionally tune the loaded profile to the clip you work with. Tuning the profile in such
a situation can make it better match the noise in the current clip. There are two available tuning methods
available:

è Use the menu Profile > Auto Fine-Tune to automatically fine-tune the loaded profile to the clip using
the current frame.

There is no need to select any area in the frame because the Auto Fine-Tune function automatically
analyzes the whole frame. If the frame contains areas showing only noise (without any details of the
scene), then Auto Fine-Tune will be able to find those and use that noise to tune the profile. If the
current frame contains no such areas, then Auto Fine-Tune will not be able to help much, so it may be
better to select a frame with suitable noise-only areas before using Auto Fine-Tune.

è You can also check and tune the profile using the Profile Check function described above in the
sub-section related to Auto Profile.

5.6. Stage VI. Adjust filter settings

è Make sure you use the Adjust and Preview tab:

The Neat Video filters have several adjustable settings. The default settings usually produce good filtration
results (provided the noise profile is accurate). You may want to additionally vary the settings to achieve
the filtration results that look best to your eyes.

5.6.1. Use preview when adjusting filter settings

The viewer in the Adjust and Preview tab shows a part or whole frame processed by the currently
enabled filters. When you change any filter settings, the preview is automatically updated. You can
zoom in and out, drag, scroll and pan the frame in the viewer to see how the Neat Video processing affects
different parts of the frame. If you manually select an area in the frame, then only the selected area will be
processed.3

When the preview is ready (the preview area shows ”Filtered” in the top right corner), you can click
inside the preview area to temporarily switch back to the original frame for comparison.

You can also select one of the adjacent frames from the same clip to see how it is processed by the filter.
To do that click one of the available thumbnails shown under the viewer.
1 Please note that you have to either build your own profiles or download some pre-built profiles for your camera and place them to

the Profile folder to make this drop-down button and popup menu truly work.
2 You can check and adjust the location of that folder using the menu: Tools > Preferences > Folders > Profile folder
3 A part of the frame is processed faster than the whole frame, so this can help when you want the preview to update quicker.
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The selected frame (highlighted with a blue border) will then be displayed in the main viewer.

The orange border highlights the thumbnails of adjacent frames used by the temporal filter.

Besides evaluation of the static frame, you can also use the playback capabilities of Neat Video. Click the

(the Play All button) to play all available frames back and forth to help you check results of
processing in motion.

5.6.2. Beginner Mode and Advanced Mode

Neat Video has two sets of controls available in Beginner Mode and Advanced Mode. You can select
the mode using the Tools > Beginner Mode and Advanced Mode menu items or using the dedicated
Beginner Mode / Advanced Mode menu in the top right corner of the plug-in’s window.

The Beginner Mode provides a simple control set recommended for beginners who have just started using
Neat Video. The Advanced Mode provides the most complete control set with maximum manual control
over the noise profiling and filtration processes. The Advanced Mode is recommended for power users.

Adjusting filter settings in Beginner Mode and Advanced Mode is described below in two separate
sub-sections.

For the Beginner Mode please follow the sub-section Stage VI (a). Beginner Mode below.

If you want to use the most complete control set in Advanced Mode then please instead follow the
sub-section Stage VI (b). Advanced Mode, page 21.

5.7. Stage VI (a). Beginner Mode

5.7.1. Beginner Mode: Temporal filter settings

Neat Video can apply both temporal and spatial noise reduction to video data. Neat Video’s temporal filter
uses information from several consecutive frames to reduce noise and better preserve details in each frame.
In this sub-section, the available settings of the temporal filter are described.

You can adjust the temporal filter using the controls in the Temporal tab in the Filter Settings panel.

Temporal Filter

In Beginner Mode, the temporal noise reduction filter itself
has one main setting: Radius.

The Radius setting determines the number of consecutive
frames used for temporal filtration. Higher values of this
setting lead to stronger (but somewhat slower) temporal
filtration based on a larger number of consecutive frames.
Lower values lead to weaker (but faster) filtration. The
default value of Radius is 2, which means five consecutive
frames (the current one, two frames before and two frames after the current one) are used for temporal
filtration.
è Use the Temporal Filter > Radius control in the Temporal tab.

17-Jan-2024 Neat Video © 1999-2024 Neatlab, ABSoft. All rights reserved. 17



User Guide Neat Video v5 plug-in for Resolve (Win)

Flicker

Neat Video also includes a special part of the temporal filter to reduce flicker – sudden changes of
brightness affecting the whole frame or parts of the frame. Flicker is often present in older film-based
videos. It may also be seen in video recorded under artificial light. Flicker may also show up as an artifact
of video compression when frames are compressed in groups and each group have a slight difference
in brightness. This often affects videos recorded by drone cameras and some mobile phone cameras. In
either case, flicker shows up as sudden changes of brightness when you play back your clip.

If you can see that in your video, try to enable this special filter in Neat Video to suppress the flicker.

è Use the Temporal Filter > Flicker > Enable checkbox
to enable or disable that filter.

Dust and Scratches

Neat Video also includes a dedicated part – Dust and Scratches – of the temporal filter that reduces or
fully removes certain defects of analog nature introduced into video data before or during its conversion to
the digital representation.

The Dust and Scratches filter reduces such defects as:

• corrupted scan lines: a whole scan line of a
video frame is incorrect;

• random short lines affecting only a small part of
a scan line;

• spots, dots, lines of relatively large size.

In the example images on the right, the areas containing
such defects are marked by blue boxes.

These defects are usually caused by:

• inaccurate recording/playing back of VHS
materials;

• damaged VHS film;

• interference in analog TV transmission;

• physical dust and scratches present in original
video film.

The common property of these defects is that each
particular defect element is present in a single frame
rather than in a series of frames. This allows Neat Video
to use information from adjacent frames to eliminate the
defects present in the current frame.

For accurate reduction of such defects by the Dust and Scratches filter, make sure you do not include
these defects into an analysis area during profiling (visually inspect the area selected by Auto Profile
to ensure that). If you include these defects into an analysis area, then the regular noise reduction may
become less accurate. The best profiling approach is to include only regular random noise (or film grain)
in the sample area used by Auto Profile for analysis.

è Use the Temporal Filter > Dust and Scratches >
Enable checkbox to enable or disable that filter.
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Use preview

While adjusting the settings, use the available preview facilities to evaluate the corresponding changes in
the results of Neat Video filtration:

• Click inside the preview area to temporarily switch back to the original frame for comparison;

• Move from one frame to another (using the thumbnails available in the bottom of Neat Video
window) to see how the Neat Video processing affects the adjacent frames;

• Use the playback capabilities of Neat Video: click the (the Play All button) to play
all available frames back and forth to help you check results of processing in motion. You can also
adjust the filter settings while the playback is running.

5.7.2. Beginner Mode: Spatial filter settings

In addition to temporal noise reduction, Neat Video can also apply its spatial filter to further reduce the
remaining noise. That may be not always necessary, since the temporal filter alone may already deliver
sufficient noise reduction. If you believe that more noise reduction is still necessary in a particular clip,
then you can enable and if necessary adjust the spatial filter to further reduce the noise.

While the temporal filter uses data from several consecutive frames, the spatial filter works within one
frame only.

In this sub-section, the available settings of the spatial filter are described. To adjust the spatial filter
settings please switch to the Spatial tab in the Filter Settings panel.

Spatial Filter

The spatial filter itself has two main settings when working
in Beginner Mode: Noise Reduction Amount and Noise
Level.

The Noise Level setting is a threshold determining which
image elements are considered noise and which elements
are considered true details. The Noise Reduction Amount
setting determines how much reduction is applied to the
elements identified as noise.

è Use the Noise Reduction Amount > Luminance
control to adjust the amount of noise reduction applied by the spatial filter to the noise in the
luminance component of the video data.

This control is the most important and most frequently adjusted setting of the spatial filter. The higher
this setting, the more of the detected noise is removed in the luminance component. Be careful,
setting the noise reduction amount too high may lead to loss of fine details and unnaturally looking
(over-smooth, plastic-like) results. Too low amounts may be not enough to sufficiently reduce the
objectionable part of the noise. The default value of 40% usually provides a good balance between
noise removal and preserving natural (not over-processed) appearance of filtered footage. Try to adjust
the setting to get the result that looks best to your eyes.

è Use the Noise Level control to adjust the noise-vs-details threshold (only when necessary).

Please note that if the noise profile is accurate,1 then it is usually not necessary to adjust this setting.
However if the noise profile is accurate but the noise is still not sufficiently reduced, then try to adjust
this setting.

Also, if the noise profile is not accurate, then also try to adjust this setting to get better noise reduction.

Use the preview to visually guide yourself when making such adjustments. The right adjustment will
leave no unreduced noise elements in the frame yet will not destroy the actual details.

1 Use the Profile Check tool and Quality indicator in the Device Noise Profile box (in the Prepare Noise Profile tab) to check the
accuracy of the profile as described in the II. Tune the profile using Profile Check (optional) section, page 14.
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Sharpening (optional)

The sharpening filter in Neat Video increases sharpness of the details in the video without increasing the
noise strength.

The sharpening filter is disabled by default. You can enable it and adjust the sharpening amounts separately
for three typical scales of details: fine, medium-sized and large.

Like any sharpening method, try to balance the sharpening amounts to avoid over-sharpening.

è Use the Sharpening > Fine, Medium and Large sliders
to adjust the amount of sharpening applied to the details
of the corresponding sizes.

It is best to start with adjusting the Fine sharpening
amount. If sharpening the fine details alone is not
sufficient to make the image look sharp, then try to
increase the Medium and Large settings too.

Use preview

While adjusting the filter settings, use the available preview facilities to evaluate the corresponding
changes in the results of Neat Video noise reduction and sharpening.

5.7.3. Beginner Mode: Optimize performance settings (optional)

Before applying the filter to the clip, you may want to check the speed of Neat Video on that clip and
potentially improve the speed by optimizing the performance settings. The processing speed depends
on the hardware capabilities, on the frame size of the video and also on the filter settings: enabling more
filters makes processing slower because Neat Video has to do more computation work. Also, if you
significantly change the filter settings, then the optimal performance settings (for example, the optimal
number of CPU cores and/or GPUs used for processing) may change as well, so it may be useful to
optimize those settings before starting a long render. This is entirely optional but in some cases, the
optimization may appreciably reduce the render time.

To check the current speed and to optimize the performance settings switch to the General tab in the
Filter Settings box.

è To measure the filter speed click in the
bottom of the General tab.

Neat Video will run a quick speed test and will then
display the measured processing speed based on the
current filter settings and frame size (as shown in the box
above in the same General tab).

Please note that it is the speed of Neat Video alone,
without any other effects that may be used in your
project and without any Resolve processing overhead.
The speed of the final render in Resolve is going to be
lower because of that overhead.

è To optimize the performance settings click to open the Performance tab in Neat Video
Preferences. In that tab, you can inspect the available and current CPU and GPU settings.

Then use to open a specialized dialog designed to measure video processing
speeds achieved with different combinations of the CPU and GPU settings. It allows to automatically
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benchmark all possible combinations of settings and to identify the best combination (for the current

frame size and current filter settings). You can then just click to apply the found
optimal combination achieving the best performance.

Once you have completed this step, please proceed to the sub-section Stage VII. Save and apply, page 35.

Or if you want to switch to the Advanced Mode and adjust all available filters using the most complete
set of controls please proceed to the next sub-section dedicated to the Advanced Mode.

5.8. Stage VI (b). Advanced Mode
If you want to use the full set of filters and filter settings offered by Neat Video, you can switch to
Advanced Mode via the Tools > Advanced Mode menu item or the dedicated Beginner Mode / Advanced
Mode menu in the top right corner of the plug-in’s window.

5.8.1. Advanced Mode: Temporal filter settings

As you already know, Neat Video can apply both temporal and spatial noise reduction to video data.
Neat Video’s temporal filter uses information from several consecutive frames to reduce noise and better
preserve details.

You can adjust the temporal filter using the controls in the Temporal tab in the Filter Settings panel.

Temporal Filter: Quality Mode

The first setting available in the Temporal Filter section
is the Quality Mode. This setting determines whether
Neat Video’s temporal filter should work faster (but
slightly less accurately) or slower (but somewhat more
accurately).

By default, Quality Mode is set to Normal, which
provides the best processing speed and good visual quality
of results. There is also High (slower) mode, which can
produce somewhat better results with more details being
preserved at expense of longer processing time (could take
about x2 longer to render).

è Use the Quality Mode control to select the preferred
processing mode.

Temporal Filter: Radius

The main setting of the temporal filter is Radius. The Radius setting determines the number of consecutive
frames used by the temporal filter for noise reduction. Higher values of this setting lead to stronger (but
somewhat slower) temporal filtration. Lower values lead to weaker (but faster) filtration. The default value
of Radius is 2, which means five consecutive frames (the current one, two frames before and two frames
after the current one) are used for temporal filtration.1

è Use the Temporal Filter > Radius control to adjust the setting.

1 Please note that some sections of Temporal Filter such as Dust and Scratches and Repeated Frames (described further in this
guide) may need more frames, which requires using higher values of Radius.
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Temporal Noise: Noise Level

If the noise profile is accurate, then the temporal filter of Neat Video will work well and will evenly
reduce all detected noise elements.

However, if the noise profile does not correctly reflect the properties of the noise (for example, if it
was built using a less noisy part of the frame) then the temporal filter may leave some noise particles
untouched or not sufficiently reduced. You will then see that in preview.

One way to avoid that is to simply re-build the noise profile using a more noisy area. It is generally best to
build profiles using the most noisy areas.

Another way is to adjust the value of the Temporal Noise > Noise Level setting to compensate for that
inaccuracy of the noise profile. This setting allows to adjust the balance between sufficient noise reduction
and preservation of details in order to leave no noise elements unreduced.

If the noise level of the video is underestimated (or overestimated) by the noise profile, then increasing
(or decreasing) the Noise Level setting from its default value of +0% to the optimum level improves the
quality of temporal filtration: more noise gets reduced with more details preserved.

Using a too high value of Noise Level may damage the
moving objects in the video, while a too low value makes
the temporal noise reduction less effective and may also
cause a noticeable flicker in the output video. Therefore
it is important to set the Noise Level to the optimum
level. Again, this is achieved automatically if you use an
accurate noise profile.

è Adjust the Temporal Noise > Noise Level setting
to achieve the balance between noise reduction and
preservation of details.

You can also use the Noise Level Check tool to visually inspect and tune the Noise Level parameter:

è 1. Click (the Begin button) to start the tuning process.

The preview will display the blue mask showing the areas where temporal noise reduction is
applied.

2. Adjust the Noise Level setting to make the mask evenly cover at least flat featureless areas that
contain no moving objects.

For example, such areas as clean sky should be covered evenly, without spots, unless there is some
moving object (the object that changes its position from one frame to another) like a bird or human
there. Moving objects should not be fully covered by the mask.

Do not raise Noise Level too high to avoid losing moving details.

It may be useful to use the playback: click (the Play All button) to play available
frames back and forth to check the mask in motion.

3. Click (the Finish button) to complete the tuning process.
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Temporal Noise: Local Flicker and Frame Flicker

The temporal filter also includes a special feature allowing to take into account possible presence of flicker
– sudden changes of brightness affecting the whole frame or parts of the frame.

Flicker is often present in older film-based videos. It may also be seen in video recorded under artificial
light. Flicker may also show up as an artifact of video compression when frames are compressed in groups
and each group have a slight difference in brightness. That often affects videos recorded by drone cameras
and some mobile phone cameras. In either case, flicker shows up as sudden changes of brightness when
you play back your clip.

Besides being distracting in itself, presence of flicker can also make work of temporal filters less accurate.
Which is why it is necessary to take the flicker into account: to correctly set the flicker levels in the
Temporal Noise section.

You may want to play back the clip to better see any flicker that may be present in it:

è Click (the Play All button) to play available frames back and forth to see if any flicker is
present.

If you see localized flickering areas within the frame, then adjust Local Flicker:

è Adjust the Temporal Noise > Local Flicker setting
from the default 0 (no flicker is present) to a higher level
until flicker disappears in playback.

If the whole frame is flickering, then instead adjust Frame Flicker:

è Adjust the Temporal Noise > Frame Flicker setting
from the default 0 (no flicker is present) to a higher level
until flicker disappears in playback.

You can also use the Local Flicker Check tool to visually inspect and adjust the Local Flicker setting:

è 1. Click (the Begin button) to start the tuning process.

The preview will display the blue mask showing the areas where local flicker reduction is applied.

2. Adjust the Local Flicker setting to make the mask evenly cover at least flat featureless areas
(flickering may be most noticeable there) that contain no moving objects.

Moving objects (the objects that change their position from one frame to another) should not be
fully covered by the mask.

Do not raise Noise Level too high to avoid overprocessing.

3. Click (the Finish button) to complete the tuning process.
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Temporal Noise: Noise Reduction Amount (optional)

The Amount setting determines how much reduction is
applied by the temporal filter to the elements identified as
noise.
è Use the Temporal Noise > Noise Reduction Amount control in the Temporal tab.

Amount can be in the range from 0% (none of the detected noise is reduced) to 100% (all the detected
noise is reduced). By default, the noise filter reduces 100% of the detected noise.

This setting should only be adjusted if noise reduction is too strong (the resulting image is too smooth)
for the selected value of Radius. Another way to make noise reduction less aggressive could be to
reduce Radius itself.

The noise reduction may also look too strong if an inaccurate noise profile is used, so it may also be
useful to check/re-build the noise profile instead of adjusting Amount or Radius.

Repeated Frames (optional)

Neat Video also offers special support for clips with repeated frames. Repeated frames are exact copies or
almost exact copies of each other.

The example below shows a typical sequence of frames from a video clip containing repeated frames:

Here the frames 1 and 2 are almost identical. Frames 3 and 4 are almost identical. Frames 5 and 6 are
almost identical or exactly identical.

At the same time, the frames 2 and 3 differ a lot (just like frames normally differ in a regular clip) because
they depict objects at different points in time. The same applies to the frames 4 vs 5.

In this example, the frames 1 and 2 (also 3 and 4, 5 and 6) are what we call repeated frames, because the
frame 2 repeats the frame 1.

Several different reasons can cause repeated frames to be present in clips:

• Camera working in “slow shutter” or “night” mode
Many models of video cameras working in such a mode introduce duplicate frames to maintain the
required frame rate of the recorded video. Those duplicate frames are usually almost exact copies
(not exact copies) due to lossy compression.

• Converting a “normal” clip into a new clip with a higher frame rate
This can also introduce new frames being copies of existing frames to achieve the required higher
frame rate. If the final clip is re-encoded, then those duplicate frames are usually almost exact
copies (not exact copies) due to lossy compression.

• In-camera noise reduction
In-camera noise reduction used in some cameras can make the noise itself being repeated from one
frame to another while the useful content of the frames (details/objects of the scene itself) changes
regularly from frame to frame. The resulting clip shows semi-static areas of noise.

Repeated frames (and repeated noise) complicate the job of the temporal noise filter because such frames
do not carry additional information needed for temporal noise reduction yet still require processing and
potentially confuse the filter.

Repeated frames also slow down the apparent speed of the clip, which means its effective frame rate is
lowered by their presence.

You can find additional video illustrations of repeated frames in the following web page:
https://www.neatvideo.com/support/how-to-use/repeated-frames

Neat Video has a dedicated Repeated Frames mode to deal with these issues. You should use the
Repeated Frames mode when you know that the clip contains repeated frames that are (1) almost exact
copies or (2) contain repeated noise. When the clip contains repeated frames that are exact copies, you do
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not need to use Repeated Frames because Neat Video can deal with exact copies automatically, without
using that mode.

If you do not know whether the clip contains repeated frames and do know the type of repeated frames,
you can check that using Neat Video viewer. Use the thumbnails in the bottom of Neat Video window to
move from one frame to the next one several times while watching the image in the main preview area
of Neat Video window (make sure you do that in the Prepare Noise Profile tab to see the original input
frames, not frames processed by the filter). If you see that the frame content is actually changing every
time you are making a step, then the clip is likely normal, it has no repeating frames. However, if you see
that the frame content (the whole content or just its noise component) is sometimes remaining static when
you are making a step, that most likely indicates that some frames are in fact repeated in the clip.

Neat Video also tries to automatically detect repeated frames that are exact and almost exact copies in
the stream of frames and marks them accordingly. The detected exact copies are marked with the white
“Copy” label in the corresponding thumbnails. The detected almost exact copies are marked with the
yellow “Rep” label. The “Rep” frames do require using the Repeated Frames mode in Neat Video, while
the “Copy” frames do not.

The image below shows an example of the thumbnails with some of the frames being repeated frames
(“Rep”):

Please note that this automatic detection may not work with all clips and in all situations, so the visual
inspection of the full resolution frames remains the most reliable test method.

The automatic detection will also not detect presence of repeated noise, so if there is a chance of noise
being repeated from one frame to another, then it is best to visually inspect the clip. Presence of repeated
noise also requires using the Repeated Frames mode.

Another means to check if the clip contains any repeated frames is the Repeated Frames Check tool
(more on that below).

Once you know that a specific clip contains repeated frames
(almost exact copies or frames with repeated noise), adjust
the Repeat Rate setting in the Repeated Frames section:

è Adjust the Repeat Rate to directly specify the amount
(in percents) of repeated frames present in the clip.

Use the thumbnails in the bottom of Neat Video window and its main viewer to estimate the percentage of
repeated frames.

Some typical values of the Repeat Rate setting are:

• 0% - all frames are unique (so the Repeated Frames mode is effectively disabled);

• 20% - each 5th frame repeats the preceding 4th frame (so 20% of all frames are repeated);

• 50% - every odd frame repeats the preceding even frame (a half of all frames are repeated);

• 66% - every second and third frames repeat the preceding first frame.

You can also use the Repeated Frames Check tool to check if repeated frames are present and to tune
the Repeat Rate setting. This function will temporarily adjust the filter in such a way as to make all
insufficiently filtered parts of the frame easier to see in preview.

To use the Repeated Frames Check tool please follow these steps:

è 1. Click (the Begin button) to start the tuning process.
The preview image will then look unnaturally plastic, but that is just a temporary effect that will go
away once tuning is complete.

2. Start with the Repeat Rate of 0% and, if noise is still noticeable in preview, gradually increase the
Repeat Rate until the noise disappears completely, while details are still preserved.
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If no noise is visible already with the Repeat Rate of 0%, then it is likely that the video does
not contain repeated frames and thus there is no need to use the Repeated Frames feature (leave
Repeat Rate at 0%).

3. Click (the Finish button) to complete the tuning process.
Please note that some noise will return to the preview image after that. This is normal. The amount
of noise reduction can be adjusted using other filter settings if required.

When working with clips that contain repeated frames (including those marked as ”Copy” and ”Rep”),
it is also generally recommended to increase the Temporal Filter > Radius to let the temporal filter use
enough frames to accurately reduce noise and preserve actual details.

Jitter of Details (optional)

Neat Video also includes a special part to reduce jitter of fine details. This video imperfection looks like as
if there was some hot air between the viewer and fine details or small objects of the scene: those details
and objects appear a bit trembling in their places (the “heat haze” effect).

That is not a real movement, but an artifact of
post-processing usually introduced by video compression. It
may also be caused by using an inaccurate noise profile in
Neat Video itself.
To reduce that visual imperfection please use the controls in the Jitter of Details section:

è Adjust the Threshold setting to find the optimum value that sufficiently reduces the jitter while not
causing any possible side-effects:

• too low values may lead to loss of sharpness while also not sufficiently reducing the jitter of
fine details;

• too high values may cause loss of fine details or unnaturally looking residual noise.

è Enable the Extended Filtration option to apply more aggressive reduction to the jitter of fine details.
This makes the jitter reduction stronger but may slow down processing.
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Dust and Scratches (optional)

Neat Video also includes a dedicated section – Dust
and Scratches – of the temporal filter that reduces
or fully removes certain defects of analog nature
introduced into video data before or during its
conversion to digital representation.

The Dust and Scratches filter is designed to reduce
such defects as:

• corrupted scan lines: a whole scan line of a
video frame is incorrect;

• random short lines affecting only a small part of
a scan line;

• spots, dots, lines of relatively large size.

In the example images on the right, the areas containing
such defects are marked by blue boxes.

These defects are usually caused by:

• inaccurate recording/playing back of VHS
materials;

• damaged VHS film;

• interference in analog TV transmission;

• physical dust and scratches present in original
video film.

The common property of these defects is that each particular defect element is present in a single frame
rather than in a series of frames. This allows Neat Video to use the data from adjacent frames to eliminate
the defects present in the current frame.

For accurate reduction of such defects by the Dust and Scratches filter, make sure you do not include
these defects into an analysis area during profiling (visually inspect the area selected by Auto Profile
to ensure that). If you include these defects into an analysis area, then the regular noise reduction may
become less accurate. The best profiling approach is to include only regular random noise in the sample
area and exclude any scratches and dust particles.

It is also very important to make sure that any flicker that may be present in the video is correctly
accounted for using the Local Flicker control in the Temporal Noise section. If the flicker is present
in the video but not suppressed by those tools, then the Dust and Scratches filter may be less efficient and
less accurate. Therefore, do pay attention to possible presence of flicker and use the Flicker controls to
suppress it before you proceed to adjust the Dust and Scratches filter.

In Advanced Mode, Neat Video offers the following settings in the Dust and Scratches filter:

è Use the Mode selector to choose between the Normal
and Aggressive modes of the filter. Identification and
reduction of dust and scratches is more exhaustive (and
somewhat slower) in the Aggressive mode.

è Use the Threshold control to adjust the strength of the filter:

• Higher values lead to more aggressive filtration with less attention to actual details;

• Lower values lead to less aggressive filtration better preserving details.

è Use the Amount control to adjust how much reduction is applied to the elements identified as dust and
scratches.
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Adapt to Changing Noise (optional)

The noise properties of the video data may slightly vary in different parts of the clip, for example if the
lighting conditions change during shooting. Neat Video can automatically adjust its processing to the
temporally changing noise.

è Enable the Adapt to Changing Noise option to let
Neat Video automatically adjust its processing to the
temporal changes in the clip’s noise.

Please note that if the noise is not changing its properties in different parts of the clip, then this option
should better be left disabled. Use it only when it is actually needed.

Use preview

While adjusting the settings, use the available preview facilities to evaluate the corresponding changes in
the results of Neat Video filtration:

• Click inside the preview area to temporarily switch back to the original frame for comparison;

• Move from one frame to another (using the thumbnails available in the bottom of Neat Video
window) to see how the noise reduction affects adjacent frames;

• Use the playback capabilities of Neat Video: click the (the Play All button) to play
all available frames back and forth to help you check results of processing in motion. You can also
adjust the filter settings while the playback is running;

• Create several alternative variants of filtration, compare results and select the best variant. For
more details please see the Variants of filtration section, page 37.

5.8.2. Advanced Mode: Spatial filter settings

In addition to temporal processing, Neat Video can also apply spatial noise reduction to further reduce
the remaining noise (if necessary). While the temporal filter uses information from several consecutive
frames, the spatial filter works within one frame only.

To adjust the spatial filter settings please switch to the Spatial tab in the Filter Settings panel.

Spatial Filter: Quality Mode

The first key setting available in the Spatial tab is the Quality Mode. This setting selects whether
Neat Video’s spatial filter should generally work faster (but slightly less accurately) or slower (but
somewhat more accurately).

By default, Quality Mode is set to Normal, which provides the best processing speed and good visual
quality of results. There is also High (slower) mode, which can produce somewhat better results with
more details being preserved at expense of longer processing time (could take about x2-x3 longer to
render).

è Use the Quality Mode control to select the preferred processing mode.
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Spatial Filter

In Advanced Mode, the spatial filter has separate settings
for all (spatial) frequency1 and channel components of
the video data. There are pairs of noise level – noise
reduction amount controls for each of these components.
You have access to eight such pairs – three for channel
components (Luminance, Cr, Cb) and five for spatial
frequency components (High, Mid, Low, Very Low, Ultra
Low) of the video data.

The meaning of each noise level – noise reduction amount
pair is the following:

• a noise level control adjusts the threshold
determining which elements of the corresponding
video component are considered noise and which
elements are considered true details;

• a noise reduction amount control determines how
much reduction is applied to the elements identified
as noise in that component.

Thus, with a noise level – noise reduction amount pair of
settings you can adjust what should be considered noise in
a channel or frequency component of the video data and how
much should that noise be reduced.

The noise level settings are relative to the noise levels of
the current noise profile, which have been measured during
profiling. Because the noise level controls are relative to the
device noise profile, their default settings usually produce
good results as long as the noise profile itself is accurate.2

1 See “What is frequency” question in page 55.
2 Use the Profile Check tool and Quality indicator in the Device Noise Profile box (in the Prepare Noise Profile tab) to check the

accuracy of the profile as described in the II. Tune the profile using Profile Check (optional) section, page 14.
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Noise Reduction Amount

Noise reduction amounts are the most frequently adjusted settings of the spatial filter.

è Use the Noise Reduction Amount > Luminance; Chrominance > Cr, Cb and Frequencies > High,
Mid, Low, Very Low and Ultra Low sliders.

You can vary the noise reduction amount for each frequency
and channel component of the video data. The higher a
certain noise reduction amount, the more of the detected
noise is removed in the corresponding component.

Noise reduction amounts can be in the range from 0% (none
of the detected noise is removed) to 100% (all the detected
noise is removed). By default, the noise filter removes
100% of detected noise in most components except the
Luminance channel where only 40% of the detected noise
is removed.

Be careful, setting the noise reduction amounts too high,
especially in the Luminance channel, may lead to loss
of fine details and unnaturally looking (over-smooth,
plastic-like) results. Too low amounts may be not enough to
sufficiently reduce the objectionable part of the noise. Try to
balance the noise reduction amounts (most importantly, the
amount of noise reduction in the Luminance channel) to get
the result that looks best to your eyes.

Decreasing the noise reduction amounts can have a positive effect if the video clip contains some natural
noise. For example, when you filter a clip including asphalt, sand, or anything else that contains fine
natural noise-like features, it may be helpful to reduce amounts down to 0-30%.

As human vision is not very
sensitive to variations of
colors, strong filtration in the
chrominance channels (Cr, Cb)
does not noticeably distort video
sequence, but efficiently reduces
color noise.

By default, the noise reduction amount in the ultra low frequency
component is set to 0%, which effectively disables noise reduction
in that component (you can always change the defaults if
necessary1). If the clip contains strong ultra low frequency noise
(like large color blobs sometimes produced by compression), then
you may want to enable the noise reduction in that components by
increasing the Noise Reduction Amount > Frequencies > Ultra
Low setting.

It may also be useful to disable the sharpening filter when adjusting the spatial noise filter to make the
influence of adjustments easier to see in preview.

Filter Tuning Assist (optional)

Filter Tuning Assist is a special tool, which facilitates adjustment of other settings of the spatial filter by
emphasizing the influence of those settings on image in preview. It is not necessary to use this tool, but it
may help to speed up the adjustment process as a whole.

Filter Tuning Assist helps to adjust such filter settings as Quality Mode, Noise Level, Artifact Removal
and other filter settings available in Advanced Mode and described further in this section.

To use the Filter Tuning Assist tool please follow these steps:

è 1. Click (the Begin button) to start the tuning process.
The preview image may then look unnaturally plastic, but that is just a temporary effect that will go
away once tuning is complete.

2. Adjust the highlighted filter settings so that no noise is visible in preview, but details are still
preserved. For example, adjust the Noise Level to make all noise elements reduced yet preserving
actual details of the scene as shown in this illustration:

1 See more about that in the description of the Default Filter Preset setting in Neat Video Preferences, page 48.
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See the next sections below for more information on adjusting Noise Level and other filter settings.

3. Click (the Finish button) to complete the tuning process.
Please note that some noise will return to the preview image after that. This is normal. The purpose
of tuning is to adjust the settings to make the noise reduction accurate, while the amount of noise
reduction can be adjusted using other filter settings, if required.

Noise Level (optional)

Usually it is not necessary to change the noise levels if the noise profile is accurate. You only need
to adjust the noise levels if you see that some noise elements are not reduced at all. Such incomplete
reduction of noise is usually caused by an inaccurate noise profile providing inaccurate noise level
estimations to the noise filter. This may be compensated by adjusting (increasing) the noise levels in the
filter settings.

è Use the Noise Level > Luminance, Cr, Cb; Frequencies > High, Mid, Low, Very Low and Ultra
Low sliders.

The noise filter is applied to five frequency components
and three channel components of the video data.
Corresponding sliders adjust the estimated noise levels
for each of these components.

The higher a certain noise level, the more elements in
the corresponding component are considered noise. Be
careful, adjusting a noise level setting too high can lead
to removal of true details. Adjusting a noise level setting
too low can lead to incomplete filtration: residual noise
and compression artifacts can stay in the filtered clip.

It may be helpful to enable Filter Tuning Assist when
adjusting the Noise Level controls because then it
is much easier to see if some noise elements are not
reduced. If there are such elements that are not reduced,
try to increase the corresponding Noise Level settings.

As a rule, if the device noise profile has been built
properly, it is not necessary to increase the noise
levels by more than 50%. If the clip contains strong
surges of noise in the high frequency range, then it is
recommended to increase the high frequency noise level
up to +20% to +40% and/or use the artifact filter (more below).

If the clip contains strong color noise, it is recommended to increase the Cr and Cb noise levels to
+30%. In some cases, it may be useful to increase these noise levels up to +100%.

If adjusting noise levels still does not help and some noise elements remain in the filtered clip, probably
the device noise profile is not good at all. Return to Stage V. Prepare a device noise profile, page 11, and
additionally fine-tune the device noise profile or simply rebuild the profile from scratch.
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Artifact Removal (optional)

Neat Video has an additional filter to remove residual
dot-like and line-like noise elements that may remain
in video even after applying Neat Video’s regular noise
filters. Such residual noise elements / artifacts are
typically created by in-camera noise reduction and
compression or by other post-processing. Neat Video’s
spatial filter can make those elements more visible if
the noise levels are underestimated during profiling.

You can see an example of such digital artifacts in
the first picture on the right. The second picture shows the results of noise reduction with the Artifact
Removal filter enabled.

Such artifacts are usually of digital nature. They are typically of very small size unlike the analog defects
treated by the Dust and Scratches filter described earlier. Since these noise elements are different than
the regular random noise, they require special treatment provided by the Artifact Removal filter.

You can adjust this filter using the following controls in the Spatial > Artifact Removal section:

è Use the Dots control to adjust the dot removal threshold.
Higher values lead to stronger reduction of dot-like
artifacts (less attention to details); lower values lead
to weaker reduction (more attention to details).

è Use the Lines control to adjust the line removal threshold.
Higher values lead to stronger reduction of line-like
artifacts (less attention to details); lower values lead to
weaker reduction (more attention to details).

The artifact filter additionally offers separate thresholds for three frequency components (in other words,
for three typical size scales) in the Frequencies sub-section: High, Mid, Low.

è Use the High, Mid and Low controls to adjust the artifact removal thresholds in the corresponding
frequency components.
Higher values lead to stronger reduction of artifacts (less attention to details); lower values lead to
weaker reduction (more attention to details).

Edge Smoothing (optional)

This option of the noise filter makes smoother the edges of
the objects in the video. This can be useful when edges are
significantly degraded by the noise (or by the in-camera
noise reduction and sharpening) and it is preferable to
restore them.

è Enable the Edge Smoothing section to enable this option in general.

è Use the High, Mid and Low controls to adjust the strength of edge smoothing in the corresponding
frequency components of the video. Higher values lead to stronger smoothing of edges; lower values
lead to less smoothing.
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Sharpening (optional)

The sharpening filter in Neat Video increases sharpness of the details in the video clip without increasing
the noise strength.

The sharpening filter is disabled by default. You can enable it and adjust the sharpening amounts separately
for three frequency components (for three typical size scales): High, Mid, Low.

è Use the Sharpening > High, Mid and Low sliders to
adjust the amount of sharpening applied to the details of
the corresponding size.

0% will not sharpen the component at all. 100% is
the normal and 250% is the maximum strength of
sharpening in each component.

It is best to start with adjusting the High sharpening
amount. If sharpening is not sufficient, try to increase the
Mid and Low settings too.

Try to balance the amount of sharpening to avoid
over-sharpening.

è Use the Range sliders available under each of Sharpening > High, Mid and Low controls to adjust
the frequency range (typical details size) to be sharpened:

• -1 - sharpening is applied to a narrower frequency range;

• 0 (default) - sharpening is applied to the normal frequency range of the frequency component;

• +1 - sharpening is applied to a wider frequency range.

You can also adjust sharpening amounts separately for three channel components – Luminance and Cr /
Cb (chrominance components):

è Use the Sharpening > Channels > Luminance, Cr and Cb sliders to adjust the amount of sharpening
applied to the corresponding channel components.

You can also sharpen in higher quality:

è Use the Sharpening > Prevent Over-Sharpening option to use a higher-quality sharpening method,
which tries to prevent over-sharpening and to avoid creating a halo around details.

Use preview

è While adjusting the filter settings, use the available preview facilities to evaluate the corresponding
changes in the results of Neat Video noise reduction and sharpening.

5.8.3. Advanced Mode: Optimize performance (optional)

Before applying the filter to the clip, you may want to check the speed of Neat Video on that clip and
potentially improve the speed by optimizing the performance settings. The processing speed depends
on the hardware capabilities, on the frame size of the video and also on the filter settings: enabling more
filters and their sub-sections makes processing slower because Neat Video has to do more work. Also, if
you significantly change the filter settings, then the optimal performance settings (for example, the number
of CPU cores and/or GPUs used for processing) may change as well, so it may be useful to try optimizing
those settings before starting a long render. This is entirely optional but in some cases it may appreciably
reduce the render time.
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To check the current speed and to optimize the performance
settings switch to the General tab in the Filter settings box.

è To measure the filter speed click in the
bottom of the General tab.

Neat Video will run a speed test and will then display the
measured processing speed based on the current filter
settings and frame size (as shown in the box above in the
same General tab).

Please note that it is the speed of Neat Video alone,
without any other effects that may be used in your
project and without any Resolve processing overhead.
The speed of the final render in Resolve is always lower
because of that overhead.

è To optimize the performance settings click
to open the Performance tab in Neat Video Preferences.
In that tab, you can inspect the available and current
CPU and GPU settings.

Then use to open a specialized dialog designed to measure video processing
speeds achieved with different combinations of the CPU and GPU settings. It allows to automatically
benchmark all possible combinations of settings and to identify the best combination (for the current

frame size and current filter settings). You can then just click to apply the found
optimal combination achieving the best performance.

Additional settings

Mix with Original

In Advanced Mode, you can additionally enable the global Mix with Original group to blend the final
result of Neat Video processing with the original unprocessed frame. That may sometimes be useful
to weaken the overall effect of Neat Video. For example, that may help to preserve the natural-looking
results or to intentionally preserve some part of the original noise to make the output compression by lossy
video codecs work better: if the final frame is very clean and smooth, some lossy compression may create
a very noticeable banding during encoding. That problem can be avoided by leaving some of the noise in.

è Use the Enable checkbox in the Mix with Original
group.

è Use the Mix control to adjust the overall mixing of the
filtered and original frame. For example:

100%: only the filtered frame is used;

50%: an equal mix of the original and filtered frames;

0%: only the original unprocessed frame is used.

è Use the Luminance, Cr and Cb controls to adjust the mixing of the filtered and original image in
individual channels.
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5.9. Stage VII. Save and apply

5.9.1. Save filter settings into a preset (optional)

This sub-step is entirely optional yet you may want to consider saving the current filter settings into a
preset on the disk. You will then be able to re-load the same settings in another clip, in the same or another
project.

To save the filter settings into a preset

è Click (the Save current filter settings as a preset. . . button) in the Filter Settings box.

Then in the Save Filter Preset As dialog box, specify the name of the file to save the preset. The filter
presets are stored in *.nfp files.

The saved filter preset includes all settings of the temporal and spatial noise filters, all their specialized
sub-sections and options, as well as the sharpening settings. By re-opening a preset later on, you can
reproduce exactly the same filter settings. Do not forget to save the noise profiles in the Device Noise
Profile tab as well. Together, a device noise profile and a filter preset can be used to accurately reproduce
the filtration results.

You can also add some text comments to your custom preset using the Preset Description dialog:

è Use to open the Preset Description dialog and add or edit the description of the preset.

The text comments are also saved into the preset on the disk when you use .

To load a previously saved filter preset

è Click (the Load filter settings from a preset. . . button) in the Filter Settings box. In the Load
Filter Preset dialog box, locate and select the filter preset to be loaded.

or

è Click (the drop-down button) in the Filter Settings box to open the popup menu with all available
presets and then select one of them.

There are several pre-written filter presets in your Documents folder:1

Documents\Neat Video v5 for Resolve\Presets\

Please try to load those presets to see what combinations of the filter settings and their values can be used
to solve typical tasks. The names of the groups of presets and presets themselves explain those tasks. Also,
when loading any of the pre-written filter presets supplied with Neat Video, the Preset Description dialog
opens automatically2 to display the description of the preset being loaded. The description is intended to
help you get a better understanding of the purpose, applicability and possible side effects of the preset.

There are two main groups of pre-written presets: General and Advanced. The presets in the first group
can be used in both Beginner Mode and Advanced Mode. The presets in the second group can only
be used when Neat Video is in Advanced Mode, so loading such a preset will switch Neat Video to
Advanced Mode (if you work in Beginner Mode).

1 You can check and adjust the location of that folder: use the menu Tools > Preferences > Folders > Preset folder.
2 You can disable displaying that dialog using the checkbox in the bottom of the Preset Description dialog (and re-enable it later in

Neat Video Preferences if necessary).
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5.9.2. Apply filter settings

Once you have prepared a noise profile and adjusted the filter settings, Neat Video is ready to apply those
changes to the clip.

To apply filter settings

è Click (the Apply button in the bottom of the plug-in window).

The Neat Video plug-in window will be closed and the plug-in will automatically save the device
noise profile and filter preset in the Resolve project you work with. You can later re-open the Neat Video
plug-in window in that clip to further adjust the noise profile and/or filter settings.

5.10. Stage VIII. Render the clip

To apply Neat Video noise reduction

è
Neat Video is a very processor-intensive filter,
so it may take significant amount of time to
render the clip. Using fast hardware (a fast CPU
and/or GPU) is recommended.

Render the clip in the regular Resolve way.
This will automatically apply Neat Video noise
reduction to the clip.

17-Jan-2024 Neat Video © 1999-2024 Neatlab, ABSoft. All rights reserved. 36



User Guide Neat Video v5 plug-in for Resolve (Win)

6. Additional tools

6.1. Variants of filtration
When adjusting the Neat Video filter settings, you may want to compare different adjustments and
select one that delivers the best visual results. You can of course manually make the adjustments and
check preview after each adjustment, but it would be easier if you could prepare several variants of such
adjustments and then quickly switch between their corresponding previews. Then it would be much
simpler to visually evaluate and compare the results.

That is exactly what variants of filtration do in Neat Video. You can create up to four variants, each with
its own set of filters settings (and possibly different noise profiles too), and quickly switch between them
to evaluate their previews. This feature is available in Advanced Mode.

Here is how you can use variants of filtration (for example in the Adjust and Preview tab):

1 To enable variants click (the Variants button) in the toolbar.

2 To create a new variant click (the Make a new variant button) in the toolbar.
A new variant will be a copy of the current variant (the current profile and filter settings).
The new variant is added to the toolbar as a new button with the corresponding name, for example

.

The new variant automatically becomes current, which is indicated by a special shading on its button.

When you make any adjustments to the profile or filter settings, they are applied and kept within the
current variant. So if you want to change the profile or filter settings in any other variant, then you
need to select that variant first and only then make any adjustments.

3 To select a variant (to make it current) click the corresponding variant’s button in the toolbar. This will
switch the profile, filter settings and preview to those of the selected variant.

If you change the profile or any filter settings, then the changes will be applied to the newly selected
variant.

4 To compare two variants (their previews) you can simply click their buttons to select them alternatively.

There is also an easier and quicker way. If you right-click another (not the current) variant’s button
instead of doing a regular left-click, then the clicked variant is only temporarily selected and the
selection returns to the previous variant once you release the right mouse button. This can be used
to quickly switch between any two variants (the current one and an alternative one) for comparison
purposes: the preview will change from one variant to another and you can easily compare them to
decide which one is better.

5 To delete an unneeded variant use its corresponding Remove variant button ( ).

6 When you are happy with one specific variant simply keep it current and it will then be used by
Neat Video for actual processing.

6.2. Skip Neat Video processing
When editing a complex project with multiple clips and multiple effects including many instances of
Neat Video, it may be useful to temporarily skip Neat Video processing to speed up editing in the host
application.

Neat Video is a very computation-intensive filter, so it may slow down the preview and affect the responsiveness
of the host application because Neat Video may be asked (by the host application) to re-calculate preview
many times. Temporary skipping Neat Video processing in these settings can make the host application’s
graphic interface more responsive.

Of course, you should re-enable Neat Video processing before the final render or when you want to check
the host-side preview that includes noise reduction provided by Neat Video.
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è To skip Neat Video processing by all instances of the filter open the Neat Video plug-in window in
one of those instances and use the menu command: Effect > Skip Neat Video Processing.

This will skip processing by all instances of Neat Video filters currently used in all clips in the current
project.

Once that command is used, Neat Video will inform you about the skipped processing status. It will
remind you about that when you re-open the plug-in window to make sure you do not forget that Neat Video
processing is being intentionally skipped. Neat Video will offer a way to re-enable its processing too, so
you always can either keep Neat Video processing skipped or re-enable it, for example before the final
render.

è To re-enable Neat Video processing uncheck that menu item – Effect > Skip Neat Video Processing
again or use the corresponding button in the information dialog shown by Neat Video.

If you restart the host application, Neat Video processing will be re-enabled automatically.

If the host application uses a render cache where it keeps earlier rendered frames, then it is best to
clear/reset that cache (after re-enabling Neat Video processing) to make sure all those cached frames
are fully processed.

6.3. Alternative modes of image viewer
The image viewer in Neat Video can show the frame in several alternative modes to enable detailed
examination of both channel and frequency components. Examining the components helps to find flat
featureless areas for noise analysis. Also, that allows to visually compare the original and filtered version
of each component and to find optimum filter settings for the corresponding component easier and faster.

è Use (Viewer mode button) in the viewer
toolbar to select the desired viewer mode.

The viewer mode will change accordingly and will display
the image components separately or as one composite
image.

Examine individual channel and frequency components
of the frame, check the presence of noise in individual
components. Working in the Noise Filter Settings tab, you
can use the separately displayed components to identify
those components that do not receive enough (or receive too
much) noise reduction and adjust the corresponding filter
settings.

You can also adjust the brightness of the viewer to easier see details and noise in very dark or very bright
areas of the frame:

è Use (the viewer brightness controls) in the viewer toolbar to adjust and/or reset the
viewer brightness to better see the noise and details in very dark or very bright areas of the frame.

Please note that this adjustment does not change the underlying video data in any way. The adjustment
only affects the viewer, i.e., the way the frame is displayed in it.
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7. Device noise profiles

A device noise profile (or noise profile, or simply profile) describes the properties of visible noise produced
by a video capturing device (e.g., a video camera, drone camera, computer TV-tuner, film digitizer, etc.)
working in a certain mode. Several noise profiles corresponding to different modes of a device constitute a
profile set for this device. Neat Video can use a profile from a profile set to process a video clip produced
by a device working in the corresponding device mode.

Earlier in Stage V. Prepare a device noise profile, it was briefly explained how to build noise profiles
automatically, using Auto Profile. This chapter describes that process in more details and also introduces
semi-automatic and manual profiling procedures. In addition, techniques for documenting and re-using
profiles are offered.

7.1. Building a profile for a device mode
(standard profiling procedure)

This subsection explains how to build a single noise profile for a video clip produced in a certain device
mode.

Building a new noise profile generally includes three stages:

Stage I. Building a profile;
Stage II. Documenting the profile;
Stage III. Saving the profile.

7.1.1. Stage I. Building a profile

To build a noise profile for a video clip you need to make these steps:

Step 1. Selecting a frame suitable for noise analysis;
Step 2. Analyzing the noise.

Step 1. Selecting a frame suitable for noise analysis

To build an accurate noise profile, Neat Video needs to analyze a specific frame from the video clip. This
frame should include uniform featureless areas containing only noise without any real details of the scene.

A uniform area (with minor variation in all color channels) may be overcast sky, clear sky (without clouds
and birds), flat wall without texture or decorations, or any other part of a suitable frame where there are no
visually perceptible details (except the noise, which should still be visible). Neat Video needs to analyze a
uniform featureless area of around 128x128 pixels or preferably larger (the minimum size is 32x32 pixels).
If the noise strength is different from frame to frame then it is better to select a frame with the strongest
noise.

Use the host application (Resolve) preview to find a frame that contains such flat featureless areas. Then
use that frame to build a noise profile:

è 1. Use the host application tools (like the time axis and preview panel) to find a frame with large flat
featureless areas; selected frame will be used for noise analysis in the next steps;

2. Add Neat Video to the clip and then click the Prepare Noise Profile button in the effect’s control
panel.
(If you run Resolve 14 or older, then please click the Prepare Frames button before using Prepare
Noise Profile.)

(If you run the Demo plug-in, click OK in the popup splash screen of the plug-in to proceed further.)

The Neat Video plug-in window will open and display the selected frame.

è At this point Neat Video may ask you to specify the scan type using a dialog window. Please select
either Progressive or Interlaced depending on the scan type of the current clip.
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Step 2. Analyzing the noise (profiling)

Analyzing noise (profiling) is the main part of building a noise profile. This version of Neat Video offers
three ways of conducting the noise analysis: automatic, semi-automatic and manual one. Using automatic
profiling is easier and therefore recommended for beginners. In difficult cases (for example if Neat Video
is unable to automatically find a uniform featureless area in the analyzed frame), automatic profiling may
not work or produce less than optimal results. You can always override automatics and use semi-automatic
or manual profiling.

è Make sure you use the Prepare Noise Profile tab:

Case of automatic profiling

To analyze the noise properties of the video clip, Neat Video uses uniform areas of the frame. Such areas
should contain noise but no visible or important details. With automatic profiling, Neat Video tries to find
one such area automatically and then it analyzes the noise in that area as well as in the rest of the frame.

è Click (the Auto Profile button).

Auto Profile will try to automatically find and select an area containing a sample of pure noise
(without any details of the scene) for analysis. Auto Profile will look for such areas in the current and
adjacent frames1 to find the most suitable area showing the strongest noise. Neat Video will then select
the found area and automatically analyze the noise in that area to build a new noise profile based on
it. Neat Video will automatically analyze the rest of the frame too. However, the most important part
of the analysis is the selected area, which is why it is highlighted in the viewer to help you visually
inspect the area to make sure there are no details or other issues there.

Once Auto Profile selects the area used for analysis, please visually inspect it to verify that the area
does indeed satisfy the following requirements (recommended to achieve the best results):

• The area should contain visible noise;

• The noise should look typical for the current clip;

• The noise should be the strongest among all such areas present in this and adjacent frames;
(you can use the noise strength indicator shown over the selection to check that)

• The area should contain no scene details of any kind (objects, textures, gradients, etc.);

• The area should contain no dust/scratches (for old film-based videos);

1 If you want to make Auto Profile look for that area in the current frame only, then click and hold the Auto Profile button and select
Auto Profile (Current Frame) in the popup menu, or use the menu Profile > Auto Profile (Current Frame). You can also hold
Shift while clicking the Auto Profile button.
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• The area should not be very dark (near black) nor very bright (near white);

• The area should be as large as possible in that frame.

Auto Profile generally tries to find areas that satisfy these requirements but that may be not always
possible to achieve. In difficult cases, it may be not able to find a large enough area or area without
details. You will then notice that the selected area, for example, contains some details or has some
other issues. In such cases, Neat Video also warns you that the area may be not very suitable for
analysis. It may say that the selected area is not uniform in one or more channels, or is small, or
contains too weak noise or clipping in some channels.

If you receive such a warning about possible non-uniformity, clipping, small size of the area, etc., then
you generally have two options:

• You can choose to ignore the warning and proceed using the area found by Auto Profile.
However, the accuracy of the resulting noise profile may be lower than it could in principle be
with that clip. Technically, the filter will still work but the quality of the results may be lower.

• You can try to resolve the reported issue using the semi-automatic profiling (see below).

If you see that the area automatically selected for analysis is indeed uniform and featureless, then
the resulting noise analysis is accurate. To be sure, check the Quality indicator in the Device Noise
Profile box. A profile built using a uniform and featureless area will usually show a high value in this
indicator.

If the profile quality is high (for example, higher than 60%), then you can be sure that the noise profile
is accurate. In this case, proceed to Stage II. Documenting the noise profile, page 45.

If the quality is not high, try to use the semi-automatic profiling instead (see below).
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Besides the Quality indicator, Neat Video offers a few more tools to help you build accurate noise
profiles.

To visually inspect areas found by Auto Profile and to manually find the most suitable areas, use
the YCrCb+ mode of the image viewer. It helps to better see any weak details that may be present
in the candidate image areas. The YCrCb+ mode emphasizes the weak details and noise present in
Luminance (Y), Cr and Cb channels, as shown in the example below:

The top image shows the original frame where details around the sun are barely visible, while the
channels in the bottom part display the image data in such a way as to emphasize those weak details.
That helps to visually verify that the selected area contains no useful details, which is very important
for accurate noise analysis. If you see that some details are present in the selected area then try to use
the semi-automatic profiling instead (see below).

Also, the Device Noise Profile box displays a histogram of the measured noise levels of the current
profile’s frequency components. (In Beginner Mode, the histogram is shown in Profile Viewer only:
menu Profile > Profile Viewer).

Normally, the histogram bars are shaded in green, which means likely-accurate measurements. Yellow
or red shadings are used to indicate likely-inaccurate measurements of the corresponding components.

It may happen that the lowest frequencies are measured inaccurately
(especially when the analysis area is small). The analysis area may seem
featureless, but may actually contain some gradient-like details. Their presence
in the analysis area may cause the noise levels to be measured inaccurately: the
noise levels may be estimated higher than they really are. An example of such
a profile with inaccurate measurements is shown in the top picture on the right.

A more accurate profiling (perhaps using a larger analysis area) could
potentially produce a better profile. Such a better profile would show a
histogram like one shown in the lower picture on the right.

If a noise profile with inaccurately measured lowest frequencies is used to
process a video clip, then those inaccurate measurements may lead to loss of
details in the corresponding frequency components.
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Case of semi-automatic profiling

1) Find a uniform featureless area

è Manually find and select an area that contains no visible details.1

The area should be as large as possible (up to the maximum of 512x512 pixels). Using a large area is
preferred because that allows to more accurately measure the properties of the noise. Using smaller
areas is possible too, but the accuracy may be reduced. The absolute minimum size is 32x32 pixels.

You can resize the selection and check its size using the W and H indicators in the bottom of the
window. Also, Neat Video will indicate which frequency components can be measured using the
selected area. For example, Good (Low Freq) would mean that all frequency components up to Low
(specifically, High, Medium, and Low) can be measured using the selected area.

Scroll, pan, zoom the image to find a uniform featureless image area. Use the YCrCb+ mode of the
viewer to better see the weak details and choose an area without details.

If the noise strength varies in different parts of frame, it is better to select an area with the strongest
noise. When you select an area in the frame, the indicator on top of the selection displays the noise
level measured in the currently selected area. That can help to find the most noisy area for profiling.
Please note that if you include any actual details in the selection, then the figure will be inaccurate. It
is accurate when you select an area containing only noise.

In Advanced Mode, the noise levels measured in the currently selected area as
well as in the area used to build the current profile are also shown by the Noise
Levels indicators in the Device Noise Profile panel. The Selection indicator
shows the overall noise level of the currently selected area. The Main Sample
indicator shows the noise level of the analysis area of the current profile (if
any).

Scroll, pan, zoom the frame to find a uniform area. Set the selection to the found uniform area.

If you cannot find a uniform area in the frame, try to use another frame from the same video clip.

2) Analyze selected area

è Click (the Build Profile button).

Neat Video will automatically analyze the manually selected area in the current and adjacent frames2

to find where the noise is strongest and to build a noise profile based on that sample.

At this point the profile is ready. Proceed to Stage II. Documenting the noise profile, page 45.

Case of manual profiling

This method is available in Advanced Mode only. You can switch to Advanced Mode using the menu
Tools.

1) Find a uniform featureless area

è Manually find and select an area that contains no visible details.

The area should be as large as possible (up to the maximum of 512x512 pixels). Using a large area is
preferred because that allows to more accurately measure the properties of the noise. Using smaller
areas is possible too, but the accuracy may be reduced. The absolute minimum size is 32x32 pixels.

Scroll, pan, zoom the image to find a uniform featureless image area. Use the YCrCb+ mode of the
viewer to better see the weak details and choose an area without details.

If noise strength is different in different parts of frame, it is better to select an area with the strongest
noise. Use the noise level indicator on top of the selection to find such an area.

1 You can see some examples of uniform featureless areas in the Examples section, page 53.
2 If you want to use that area from the current frame only, then click and hold the Build Profile button and select Build Profile

(Current Frame) in the popup menu, or use the menu Profile > Build Profile (Current Frame).
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2) Analyze selected area

è Click (the Build Profile button).

Neat Video will automatically analyze the selected area and build a noise profile.

3) Additionally manually fine-tune the profile

Fine-tuning uses additional flat featureless areas to make the noise profile more accurate. You can
manually select and analyze several such areas one after another.

1) Find and select a uniform featureless area

è Scroll, pan, zoom the frame in the viewer in the Prepare Noise Profile tab to find and select a new
uniform area.

The size of an area may be from 16x16 to 512x512 pixels. Using larger areas makes fine-tuning more
accurate. Please notice that the edges of the selection box change their thickness as the size reaches
certain size thresholds. That is meant to help you select a sufficiently large area.

2) Analyze selected area with Manual Fine-Tune

è Click (the Manual Fine-Tune button ) or select the Profile > Fine-Tune Using Selected Area
menu item.

The analysis results will be shown in the noise profile
equalizer: the graphs of the equalizer will change some
of the values (see the picture on the right). You can
switch from one channel to another in the equalizer to
better see a specific channel’s graph, or select to show
them all together.

The goal of manual fine-tuning is to fill the equalizer
with measured values (shown as knots filled with the
color of the corresponding graph) in all points of the
graphs. The previous steps (specifically, the Auto Profile
function) may have already filled some of the values.
Manual fine-tuning can further improve the analysis by
filling out the still missing or interpolated values (shown as yellow knots) and/or making some of
already measured values more precise.

3) Repeat 1-2 above with other uniform areas of different brightness

To make a device noise profile more accurate, fine-tune it using several uniform areas of the frame.
Select areas of different brightness for best results. Try to choose and analyze uniform areas to
cover all or most elements of the equalizer in all its color channels. The more elements of profile
are analyzed, the higher is the quality of the profile.

4) Complete fine-tuning using Auto Complete

è Click (the Auto Complete button ) or select the Profile > Auto Complete menu item to automatically
finalize the fine-tuning by adjusting the unmeasured values using interpolation based on the measured
data.

At this point the profile is ready. Proceed to Stage II. Documenting the noise profile.
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7.1.2. Stage II. Documenting the noise profile

At this point the noise analysis is done and all important
noise characteristics are gathered in the profile. If you are
going to use this profile more than once, then you may want
to additionally document the profile by describing the video
capturing device and its mode.

è Use the Device Name and Mode fields in the Device
Noise Profile box to specify the model of the video
capturing device and describe the device mode used to
capture the profiled clip.

It is recommended to specify these details to keep record
of devices, device modes, and corresponding device
noise profiles that you use.

The noise characteristics of any two devices can be extremely different. Even a single device can
produce significantly different noise when working in different modes. Therefore, it is always better
to use separate noise profiles for different devices and device modes to avoid inaccurate filtration,
insufficient noise reduction and/or artifacts. Commenting on the device name and device mode
parameters will help you re-use a noise profile later when you look for a suitable profile to process a
video clip.

There may be many device parameters, but not all of them influence noise and those that do differ by
the strength of their influence. It makes sense to document only those parameters that appreciably
affect noise. In the table below, those parameters are described that usually appreciably affect noise
characteristics (from the most to the less important ones) for video capturing devices:

Parameters of video capturing device in the order of decreasing importance

Sensitivity of
light-capturing
device

Film type and sensitivity
(for digitized analog
video), effective sensor
sensitivity like ISO rate
(for digital video), etc.

More sensitive light-capturing devices / shooting
mode / media usually produce stronger noise.

Compression
of video clip

Video compression
method (codec) and its
mode.

Stronger compression typically produces more
artifacts and destroys details; weaker compression
preserves more details. It is preferable to use the
lowest amount of compression possible for the best
results.

Resolution,
frame size

3840x2160, 1920x1080,
1280x720, 720x576,
352x288, etc.

Video clips in different resolutions usually have
very different noise characteristics.

If two video clips were produced by the same device in the same or similar conditions (most of the
above device mode parameters are the same), then the noise of these two clips should be very similar.
If you have built a device noise profile using one of these clips, you can use this profile to filter both
clips with good results. If however, the conditions were different, then the noise in two clips could be
significantly different. In this case, cross-use of the noise profile is not recommended. Instead, two
different profiles should be built and used to filter these two clips.
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7.1.3. Stage III. Saving the noise profile

è Use (the Save Device Noise Profile As. . . button) in the Device Noise Profile box.

In the Save Device Noise Profile As. . . dialog box, specify a meaningful file name and save the
profile to the hard drive. Device noise profile are saved in *.dnp files.

File naming considerations

If you are going to re-use the device noise profile, select a good file name explaining the device
name and mode so that you could easily recognize this profile by its file name later on. You can
also use some folder structuring to keep many device noise profiles arranged into sub-folders
according to the device modes.

The saved noise profile includes the complete noise analysis done by Neat Video when you built the
profile. Therefore by re-opening the noise profile with another clip later on, you can reproduce exactly
the same conditions for noise reduction. Please note that you also need to keep a copy of the used filter
preset to be able to reproduce the same noise reduction.

7.2. Using noise profiles
When you have a set of profiles for different modes of your video capturing device, you can directly use
those profiles to process clips using Neat Video. Usually such a set contains only one profile that is most
suitable to process a given clip. Therefore it is very important to select the right profile, which would
provide the closest match between the profile and the clip. To achieve such a match, the device mode of
the chosen profile should be the same or very close to the device mode used to capture the clip. So you
need to manually select a device noise profile that matches the video clip based on profile descriptions and
file names.

Obviously it is preferable to build a new noise profile for each clip, because such a profile would perfectly
match the noise of that clip. Nevertheless, any noise profile can, with some degree of accuracy, be used to
process other clips captured by the same device working in the same or similar mode. This is less accurate
than building a profile for each clip but saves time because building a new profile may take more time than
re-using a ready-made one.
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8. Preferences

There are several preferences that adjust the behavior of the Neat Video plug-in.

Use the Tools > Preferences. . . menu item to open the Preferences dialog box.

8.1. General preferences

On opening plug-in window

Do not change viewer zoom and window size

Select this option to make Neat Video do nothing (like adjusting the window size and zoom level) when
opening the plug-in window. The Neat Video window will remember its size from the last time and will
not try to adjust its size and viewer zoom to show the whole frame. The initial zoom level will be 100%.

Adjust viewer zoom to fit frame to window

Use this option to make the Neat Video viewer automatically adjust the zoom level to fit the whole frame
into the viewer window, without modifying the window size. The Neat Video window will remember its
size from the last time.

Adjust window size to accommodate whole frame

Use this option to make the Neat Video windows automatically adjust its window size (and if necessary,
the viewer zoom level as well) to accommodate the whole frame when opening the Neat Video plug-in.

Color theme

Normal brightness

Neat Video will display its interface elements using the color theme with normal brightness.

Reduced brightness

Select this option to switch Neat Video to a custom color theme with reduced brightness.

Auto-detect brightness

Neat Video will try to detect the system color theme and adjust its own color theme accordingly.

Updates

Periodically check for software updates

Neat Video can automatically access the Internet to check whether an updated version of the plug-in is
available on the webpage of Neat Video.

Unless this option is disabled, Neat Video will automatically look for updates every few days.

You can also manually run such a check using the Check Now button available there.

Neat Video will display the currently installed version of the software as well as the latest available
version of the product that can be downloaded. When a newer version is available you can use the
provided download link to visit the download area to download and install the updated version.

Show hints over interface controls

This option switches on/off the hints explaining the purpose of Neat Video controls (like a button, slider,
etc.). The hints are displayed when the mouse pointer is placed over controls in the Neat Video interface.
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8.2. Defaults

Default Device Noise Profile

This setting selects how a noise profile should be prepared by Neat Video when a new instance of the filter
is created (for example, when you add Neat Video to a clip). There are two possible ways:

Do not prepare noise profile automatically

When this option is selected, Neat Video does not automatically prepare a new noise profile. You then
should prepare a noise profile manually, for example, by building it using Auto Profile.

Use specified default profile

When this option is selected, Neat Video automatically loads the specified noise profile from the disk.

This may be useful when you work with many clips shot by the same camera in the same shooting mode
when the noise is the same in all clips. In such a situation, you can simply build a quality noise profile for
one of those clips, save it to the disk, specify it here in this option and then add Neat Video to all other
clips. All the newly created instances of Neat Video will automatically load and use the profile.

Default Filter Preset

This setting selects the filter preset to be used when a new instance of the filter is created (for example,
when you add Neat Video to a clip) or when you reset the filter settings (in the Adjust and Preview tab).

Program’s default settings

When this option is selected, Neat Video will use the defaults pre-programmed in the plug-in.

Specified custom preset

When this option is selected, Neat Video automatically loads the specified filter preset from the disk.

Using this option, you can make any existing filter preset to work as default in Neat Video.

You can also save you own preset and make it default.

Default Video Scan Type

This setting controls the scan type to be used when a new instance of the filter is created.

Ask every time a new instance of filter is added to video

When this option is selected, the scan type selection dialog will be shown every time a new instance of
the filter is created. If you choose to not show that dialog (using the corresponding option available in the
dialog itself) then it will not be shown again. You can always return to displaying that dialog by adjusting
this option here.
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Do not ask, remember scan type used last time

When this option is selected, Neat Video will not show the scan type selection dialog when a new instance
of the filter is created. The previously used scan type will be automatically selected. You can always
manually adjust the scan type using the corresponding control in the left bottom corner of the Neat Video
plug-in window.

8.3. Profiling preferences

Save noise samples in profiles

Enable this option to make Neat Video save a noise sample from the analyzed frame area into a device
noise profile (*.dnp) file. This will increase the size of the *.dnp file but will also improve the compatibility
with the future versions of the software (Neat Video will be able to re-build the profile using the saved
noise sample).

Show warnings about selected frame areas

Enable this option to let Neat Video display warnings about selected frame areas during profiling. For
example, Neat Video may warn you about clipping or non-uniformity detected in the selected area, thus
helping you select a better area for profiling. If you do not need such kind of assistance you can always
disable this option.

8.4. Preview preferences

Preview cache size

Use this option to set the size of the preview cache memory used by Neat Video. The preview cache
memory allows Neat Video to faster display previews when you adjust the filter settings, use playback,
switch between variants, etc. When you work with larger frames, more memory is needed for the cache.
Please see the comment in this setting to select the cache size sufficient for playback in specific resolution.

8.5. Performance preferences
The first group of settings in this tab selects the computing devices to be used for video processing. This
group of settings is optional: it is shown only if at least one supported GPU (graphic processing unit)
is available along with the regular CPU (central processing unit, or processor). This group includes the
following items:

Use CPU only

This option makes Neat Video perform all video processing using the CPU only.

Use GPU only

This option makes Neat Video perform all video processing using the GPU only.
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Use CPU and GPU

If you select this option, then Neat Video will process video data using the CPU and GPU.

Depending on individual performance of each computing device (CPU and GPU), each of the above
options may be the most efficient. You can try different settings and measure the resulting speed using the
Check Speed tool below. You can also use the Optimize Settings. . . button to automatically measure all
possible combinations and find the best one. More on that below.

Optimize Settings

Use the Optimize Settings. . . button to open a specialized dialog designed to measure Neat Video’s
processing speeds achieved with different combinations of the CPU and GPU settings. This tool allows to
automatically benchmark all possible combinations of settings and to identify the best combination. This
is the easiest way to optimize the performance of Neat Video for specific CPU and GPU hardware.

CPU

Number of used cores

This option adjusts the number of CPU cores used by Neat Video for processing. The number of used
cores can go up to the total number of cores in all CPUs in your computer (like 2 cores in Core Duo, 4
cores in Core Quad, 8 cores in a desktop version of i7 with enabled hyperthreading, etc.). If the computer
includes two physical CPUs, then the number of cores is correspondingly higher. Ideally, using all cores
should provide the best overall performance. In some cases however, processing speed may be even higher
if only some of cores are used (especially on CPUs with hyperthreading). For example, using fewer than
all 8 virtual cores of some i7 CPUs is in some cases faster. You may want to test different values of this
setting. Use the Optimize Settings tool described below to find the best number of cores.

GPU

In this box, you can specify which of the available computation-capable GPU devices (CUDA-capable
NVIDIA cards and/or OpenCL-capable AMD cards) should be used by Neat Video in addition to the CPU
or instead of the CPU for video processing. When you have one or more GPUs, you can let Neat Video
use those and specify how much of the available GPU memory may be used by Neat Video for its
processing. If another application or another filter also uses the GPU at the same time, then you may
want to reserve only a part of the GPU memory for Neat Video and leave the rest free for other purposes.

When adjusting the amount of GPU memory using the slider, pay attention to the small triangle under
the slider. It shows an estimation of the optimal amount of GPU memory required by Neat Video for
processing of video with the current frame size. If you adjust the setting to that amount, then Neat Video
will have a sufficient amount of the GPU memory and the rest of the memory will remain available to
other GPU users. If you adjust the setting below that optimal amount, then the speed of Neat Video
may be somewhat decreased. If you adjust the setting above the optimal amount, then the speed will not
increase (as compared with the optimal setting).

GPU Advanced Settings

Use the Advanced Settings. . . button to open a specialized dialog and verify the GPU detection log for
errors or problems reported there. That can help in a situation when one or more of the GPUs of your
computer are not visible in Neat Video or cannot be enabled. The GPU detection log may offer some
insight into the possible causes.
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Enable GPU support

You can completely disable GPU support via CUDA / OpenCL using the corresponding checkboxes
available in the dialog. You can use that for troubleshooting purposes.

Enable Resolve GPU interface

Using this option you can enable communication of Neat Video with Resolve via the GPU interface of
Resolve. This can in some cases improve the render speed.

Please note that GPU memory consumption by Resolve will be higher if this option is enabled, so it makes
practical sense to enable this option only on machines with GPU(s) that have large GPU memory.

Also, it might be impossible to use Neat Video in the Fusion page in Resolve when this option is enabled,
due to the current internal limitations of Resolve itself.

Check Speed

Use the Check Speed button to measure the speed of Neat Video processing with the current filter settings
and current performance settings specified in the CPU and GPU boxes.

8.6. Folders preferences

Profile Folder

Select the folder where Neat Video must store and look for its device noise profiles. This should be the
topmost folder of all the (sub)folders with device noise profiles. Neat Video will display all profiles
(stored in all subfolders of the specified folder) in the popup menu in the Device Noise Profile panel of the
plug-in window to help you quickly load those profiles.

By default, the Profile Folder is located in your Documents folder:
Documents\Neat Video v5 for Resolve\Profiles\

You can select another location to store and use noise profiles if you like.

Preset Folder

Select the folder where Neat Video will look for filter presets. This should be the topmost folder of all the
(sub)folders with filter presets. Neat Video will display all presets (stored in all subfolders of the specified
folder) in the popup menu in the Filter Settings panel of the plug-in window to help you quickly load
those presets.

By default, the Preset Folder is located in your Documents folder:
Documents\Neat Video v5 for Resolve\Presets\

You can select another location to store and use filter presets if you like.

Show preset description on load

When you manually load a filter preset from the disk, Neat Video automatically opens the Preset Description
dialog to display the description of the preset being loaded.

This is very useful with the pre-written presets supplied with Neat Video: their descriptions are shown
to help you get a better understanding of the purpose, applicability and side effects of the corresponding
preset.

You can disable displaying that dialog if you want. In that case, you can still access the Preset Description
dialog using in the Filter Settings box.

Folder History

You can adjust the way the file dialogs work in Neat Video using the settings available in this subsection:
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Use independent folders for profiles and presets

When this option is enabled (default), Neat Video will use separate current folders for the file dialogs that
work with noise profiles and with filter presets.

If you disable this option, then Neat Video will use the same common folders for the file dialogs working
with both profiles and presets.

Use independent load and save folders

If you enable this option (it is disabled by default), Neat Video will use separate current folders for the
load and save dialogs (for example, the profile loading and profile saving dialogs).

When this option is disabled (default), Neat Video will use only one current folder for the load and save
dialogs.
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9. Examples

9.1. Building a noise profile
See the picture below for examples of areas that are good and bad for building device noise profiles. Here,
the areas suitable for profiling are highlighted in green; those that should not be used are highlighted in
red. Note that a frame area suitable for building a device noise profile should be at least 32x32 pixel large
(preferably more than 128x128 pixels).

Additional comments regarding these areas are available in the next page.

17-Jan-2024 Neat Video © 1999-2024 Neatlab, ABSoft. All rights reserved. 53



User Guide Neat Video v5 plug-in for Resolve (Win)

These areas can be used to build device noise profiles, as they contain no visible details:

— GOOD, because this area contains no important details

— GOOD, no important details (this area is from another frame)

The following areas should not be used to build device noise profiles, because they contain details:

— BAD, because this area contains a detail: corner – junction of wall and
ceiling

— UNACCEPTABLE, because this area contains many details

— BAD, because this area contains some details: clouds (this area is from
another frame)

9.2. Filtration results
Please see examples of noise reduction applied to video clips in the Neat Video web page:
https://www.neatvideo.com/examples
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10. Questions and answers

10.1. General questions
Q What is the difference between Neat Video Demo, Home and Pro plug-in?

A The Demo plug-in has some functional limitations. For example, it can only process short video clips
and it will filter only a limited area inside the frame. Please see the Detailed feature map, page 57 , for
more details.

Q Should I uninstall Demo plug-in prior to installing the Home / Pro plug-in?

A This is not necessary. You can install the Home / Pro plug-in over the Demo plug-in. Please make sure
the host application is completely closed when you are installing the Home / Pro plug-in.

Q Should I uninstall the older version of Neat Video prior to installing a newer one?

A This is not necessary. You can simply install a newer version of Neat Video. It will either replace the
older one or will be available along with the older one (depending on the version).

Q I think I have found a bug. How can I submit a bug report?

A Please use the online bug report form: https://www.neatvideo.com/support/report-bug
Please fill it out to let us know all the details necessary to reproduce the problem.

See the Known issues section in Neat Video webpage
(https://www.neatvideo.com/support/known-issues) and also see the History of changes for the
most up to date information: https://www.neatvideo.com/features/version-history).

10.2. Filtration-related questions
Q Why do I receive some crystal-like artifacts in the filtered frame?

A The crystal-like artifacts (usually these are the residual compression artifacts or residual noise) look
like thin lines in the filtered frame. They can be eliminated by increasing the high frequency noise
level in the filter settings or by using the dedicated Artifact Removal filter described in page 32.

Note: presence of many residual artifacts may be caused by using a poorly built, inaccurate noise
profile or a profile built for another device and/or device mode.

Q Filtered frame looks ‘plastic’. Why?

A The reason is that too much filtration was applied. Let Neat Video keep some noise to have
natural-looking results. Adjust the noise reduction amounts; for example, reduce the noise reduction
amount in the Luminance channel to 10-30% or even to 0% (in the Spatial section). Also, make sure
the device noise profile does match the video clip processed. Using an incorrectly chosen or poorly
built profile can either produce plastic-looking results or leave residual artifacts (see the previous
question).

Q What is frequency?

A The term (spatial) frequency is used in Neat Video to denote elements of a video clip (both important
details and noise/grain) of certain size.

High frequency corresponds to elements of smallest size. Medium (Mid) frequency
corresponds to elements of medium size. Low, Very Low and Ultra Low frequency
correspond to elements of correspondingly larger sizes.

For reference, see the noise samples of different frequencies in the Noise Filter
Settings tab of the Neat Video plug-in window.

Q The filtration process is not very fast, is this normal?

A This is normal, because the Neat Video noise reduction algorithms are quite complex. We
continuously work on further optimizations to provide better performance.
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Q How to filter only the color noise (not the brightness noise)?

A Make sure you work in Advanced Mode and go to the Adjust and Preview tab, to the Filter Settings
panel, open the General section, enable the Mix with Original option and set Mix to 100% and
Luminance to 0%. This will disable all noise reduction in the luminance (brightness) channel.

Q What is YCrCb?

A YCrCb is the name of a family of color models widely used in digital imaging, television, video,
etc. In ‘YCrCb’ , ‘Y’ corresponds to the luminance channel , ‘Cr’ - to the Cr chrominance channel
covering the red to blue-green color range, ‘Cb’ - to the Cb chrominance channel covering the blue to
yellow color range. Because this color model separates the luminance and chrominance information, it
is used for noise reduction where different processing is required in the luminance and chrominance
channels.

Q Is processing via Neat Video best done before or after any other processing (i.e. tonal/color
correction)?

A Such operations as tonal/color correction are quite conservative from the standpoint of noise, which
means they do not significantly change the noise characteristics of the video clip. Therefore, filtering
before or after makes little difference – as long as the noise profile is built and applied at the same
stage of your workflow. For example, do not use a device noise profile built with an unprocessed (the
color correction is not yet applied) clip to filter the same clip with the color correction already applied.

On the other hand, certain effects, like sharpening or resampling, applied to a noisy video clip may
considerably change its noise properties. In this case, it is generally better to use Neat Video filtration
before applying such effects.
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11. Information

11.1. Issues and bugs
Please report any bugs or issues you encounter while working with Neat Video. Use the online bug report
form: https://www.neatvideo.com/support/report-bug

Your feedback will greatly help us to improve the software and provide you with newer and better versions
of Neat Video.

11.2. Plans
The current version of Neat Video is the result of our ongoing research on noise filtration. We continue to
work on the core noise reduction algorithms to improve the quality and speed of noise reduction.

Please let us know if you have ideas that can make Neat Video better. Please participate in the discussions
taking place in the Neat Video forum: express your opinion, make suggestions and ask questions.

11.3. Detailed feature map

Neat Video

Demo plug-in Home plug-in Pro plug-in
Use for commercial purposes not allowed not allowed allowed

Optional GPU acceleration +

Ability to use two or more GPUs simultaneously – – +

Video data

File formats supported all formats supported by plug-in host

8/16/32 bits/channel rendering +

Maximum size / length of filtered video
data

1280x720
pixels

15 minutes

1920x1080
pixels

unlimited
length

unlimited size
unlimited

length

Neat Video watermark added to filtered clip added not added

Spatial and temporal filters, all modules +

Noise
reduction

Channel components (Luminance, Cr, Cb) +

Frequency components (High, Mid, Low,
Very Low, Ultra Low) +

Smart
sharpening

Channel components (Luminance, Cr, Cb) +

Frequency components (High, Mid, Low) +

Device
noise
profiles

Automatic and semi-automatic profiling of
any video-capturing device +

Filter presets (reusable filter settings) +
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11.4. Contacts
We really appreciate your opinion of Neat Video. Please let us know what you think about the software.
Feel free to ask questions regarding Neat Video. You can contact us using the following means:

E-mails

info@neatvideo.com for general inquiries about Neat Video

resolve@neatvideo.com for any inquiries regarding use of Neat Video for Resolve

sales@neatvideo.com for any inquiries regarding purchase of Neat Video software

Forum

Register in the Neat Video community forum ( https://www.neatvideo.net/ ) and participate in discussions
related to the use and development of Neat Video. Such topics are covered in the forum as:

• announcements of new and updated version of the software;

• questions about use of Neat Video;

• examples of using Neat Video with comments and suggestions;

• feedback from the users: suggestions of new features and improvements;

• general comments;

• backup contacts.

Web page

https://www.neatvideo.com/

11.5. Legal information

Copyright

Neat Video © 1999-2024 Neatlab, ABSoft. All rights reserved.

License agreement

You can find the End-User License Agreement (EULA) covering this product – Neat Video v5 plug-in for
Resolve (Win) – in the file Legal.txt supplied with the product.

11.6. Purchase
To become a licensed user and to get a fully functional copy of Neat Video Home or Pro plug-in for
Resolve (Win) you need to purchase a license for this product. Please find the detailed information and
current prices in the Purchase section of the Neat Video web page:
https://www.neatvideo.com/purchase

After purchasing a license, you receive an e-mail from the Neat Video team with detailed download and
registration instructions. Using those you will be able to download, install and register the software on
your computer.

By becoming a licensed user of Neat Video Home or Pro plug-in for Resolve (Win) you will:

• Encourage the authors to further develop and improve the software;

• Get access to all functions of Neat Video Home or Pro plug-in for Resolve (Win)
(see the Detailed feature map, page 57);
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• Pro plug-in only: be able to use Neat Video for Resolve (Win) for commercial purposes;

• Get free updates of the software (minor modifications with the same major version number, for
example, updates from the version v5.0 to any v5.x);

• Enjoy reduced upgrade prices for new major future modifications of Neat Video Home or Pro plug-in
for Resolve (Win);

• Receive the primary attention of Neat Video support group;

• Receive the primary attention of Neat Video development group
(tell us what you want to see in the next version).

Message from Neat Video team

By purchasing our product you are helping us to further develop and improve the software.

Become a registered user and we will make Neat Video better for YOU!

11.7. Acknowledgments
Thank you very much to all the people who contribute by proposing improvements and new features.

Thank you very much to all the people who help us to find bugs in Neat Video.

Thank you very much to those who stimulate the development of Neat Video by word and deed.

Neat Video team
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Index

Adapt to Changing Noise,
28

Adjust and Preview, 16
Apply filter, 36
Artifact Removal, 32
Auto Complete, 44
Auto Fine-Tune, 16
Auto Profile, 12, 40
Build Profile, 43, 44
Check Speed, 20, 34
Dust and Scratches, 18, 27
Edge Smoothing, 32
Filter Tuning Assist, 30
Flicker, 18
Input Data Type, 10
Jitter of Details, 26
Load Profile, 15
Manual Fine-Tune, 44
Mix with Original, 34
Mode

Advanced Mode, 17,
21

Beginner Mode, 17
Noise Level, 19, 29, 31
Noise Reduction Amount,

19, 29, 30
Optimize, 20, 34
Prepare Noise Profile, 12
Quality Mode, 21, 28
Repeated Frames, 24
Sharpening, 20, 33
Spatial Filter, 19, 29
Temporal Filter, 17, 21

adapt to changing noise, 28
apply filter, 36
artifact removal, 32

color model
chrominance, 56
luminance, 56
YCrCb, 56

color noise, 31, 56
compatibility

Resolve versions, 5
contacts, 58

e-mails, 58
forum, 58

web page, 58

device noise profile, 11
building, 39

automatic, 12, 40
manual, 43
semi-automatic, 43
standard procedure,

39
documenting, 45
parameters, 45
quality indicator, 14, 41
saving, 46
using, 46

dust and scratches, 18, 27
amount, 27
mode, 27
threshold, 27

edge smoothing, 32
examples, 53

feature map, 57
features, 3
filter preset, 35, 36

description, 35
load, 35
save, 35

flicker, 18
frequency, 55

high, 29–31, 55
low, 29, 30, 55
mid, 29, 30, 55
ultra low, 29, 30
very low, 29, 30

frequency range, 6, 54

gamma correction, 10
globally disable, 37
GPU acceleration

CUDA, 4
OpenCL, 4

input data type, 10

jitter, 26

license agreement, 58
linear, 11

mix with original, 34

night mode, 24
noise filter, 6
noise level

spatial filter, 29, 31
temporal filter, 22

noise reduction amount, 29,
30

performance settings
optimize, 20, 33

plug-in
installation, 7
installer, 7
main window, 9

preferences, 47
preview, 19, 28
purchase, 58

quality mode
spatial filter, 28
temporal filter, 21

repeated frames, 24

sharpening, 20, 33
skip processing, 37
slow shutter, 24
spatial filter, 19, 29

noise level, 19, 29
noise reduction amount,

19, 29
quality mode, 28

spatial filter settings, 19, 28
spatial filter tuning, 30
system requirements, 4

temporal filter, 21
amount, 24
frame flicker, 23
local flicker, 23
noise level, 22
quality mode, 21
radius, 17, 21

variants of filtration, 37
viewer modes, 38
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